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Introduction

What is Lan Script?

In the past, distributing software over a network with Microsoft SMS has involved complex
and time-consuming scripting. You had to learn the scripting language, create, install and test
the scripts, and manually maintain the scripts throughout their life.

ABC Lan Script automates the procedure for generating software distribution packages for
Microsoft Systems Management Server (SMS).

Lan Script has been designed specifically to be uncomplicated and easy to use, whilst still
offering all of the power offered by complex scripting languages.

How Does Lan Script Work?

Lan Script obtains the details needed to generate distribution scripts by means of a wizard that
guides you through a high level process. At each stage, recommendations are made and
suggested entries are offered to you that will be correct in most cases.

The wizard works by monitoring an installation of the software, and comparing a snapshot of
the system taken prior to the installation with a snapshot taken afterwards. It then identifies the
differences between the two snapshots, and creates the scripts required from these details.

An editor is available to manually customise scripts for your environment and create similar
scripts by making minor changes.

Completed scripts are uploaded by Lan Script to Microsoft SMS as a package and
registered. The software is then available for installation to your networked workstations
using all of the powerful scheduling and distribution facilities provided by Microsoft SMS.
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Benefits and Features

• Time saving
A typical installation script can be generated in a matter of minutes.

• Ease of use
Lan Script automates the script generation and upload procedure. No scripting or
programming training is required.

• Compliments Microsoft SMS
Lan Script has been specifically designed to work in conjunction with Microsoft SMS.

• Full control
You can specify the directories and files to be monitored during the script creation
process, and choose whether to incorporate changes made to the System Registry.

• Detects program groups, icon, and start menu shortcuts
The 16 bit version of Lan Script detects and replicates Program Manager groups and
icons. The 32 bit version detects Start Menu shortcuts.

• Detects version changes
You have the option of checking each file’s version stamp when determining whether a
file has been updated.

• Automatic rollback, should an executing script fail
The scripts created enable you to reinstate your workstations to a working state,
should you encounter errors with an installation.

• 32 bit registry and long filename support
The 32 bit version of Lan Script supports 32 bit registries using source code licensed
from Microsoft, and long filenames of up to 256 characters.

• Status MIFs
The Lan Script install client generates a status MIF for each distribution to a
workstation or server, indicating the success or otherwise of the distribution. Should a
job fail, the status MIF reports the error that occurred and indicates whether the
workstation was restored.
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• Supports environment and system variables
Lan Script supports the use of environment variables in the scripts generated. There
are also five strings that you can use when writing a script which will be substituted by
Lan Script when the script is executed.

• UNC path support
All commands are fully supported by UNC paths. This is an essential feature for
enterprise systems.

• Auto-registering of packages with Microsoft SMS
Lan Script automatically registers scripts created as a package within Microsoft SMS.

• Auto-inclusion in the Microsoft SMS inventory
You can choose to include the package created in the Microsoft SMS software
inventory.



ABC Lan Script

x

About This Guide

This guide explains how you use Lan Script to create scripts and distribute software on a
network using Microsoft SMS. It contains five chapters and two appendices:

• Chapter 1: Lan Script Essentials provides a high-level explanation of the procedure
for script generation and distribution, and introduces the menus and options available.

• Chapter 2: Generating Scripts provides a step-by-step breakdown of the procedure
for using the Lan Script Create Package wizard to generate scripts.

• Chapter 3: Editing Scripts explains how you can view the scripts and package details
created. You can manually edit the scripts if required, e.g. to create similar scripts by
making minor changes.

• Chapter 4: Uploading Scripts to Microsoft SMS explains how the script is uploaded
by Lan Script to Microsoft SMS as a package and registered.

• Chapter 5: Distributing Packages to Your Workstations explains how to use
Microsoft SMS to distribute the package to your workstations.

• Appendix A: Installation Instructions explains how to install the Lan Script service on
your server, and the Lan Script application on your client workstation.

• Appendix B: Scripting Commands provides a reference of the commands available to
manually edit the script created.
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Explanation of Symbols

Throughout this manual the following symbols are used to emphasise important points about
the information you are reading:

"
Special note. This symbol indicates further information about the topic you are working on.
These may relate to other parts of the system or be points that need particular attention.

� Time. This symbol means that a ‘short-cut’ that may save you time is being described.

0
Warning. This symbol means that proceeding with a course of action may result in a risk,
e.g. loss of data or potential problems with the operation of your system.

16 bit version. The instructions alongside this symbol are relevant to the 16 bit version of
Lan Script only.

32 bit version. The instructions alongside this symbol are relevant to the 32 bit version of
Lan Script only.

Typefaces

The following typefaces are used throughout this manual:

• This typeface (courier) is used to represent messages or other

information the system displays on the screen .

• This typeface (italic) is used to represent fields and menu options, and also for
cross-references.

• This typeface (bold) represents data you type in at the keyboard, including
menu selections.

Related Documents

This guide should be used in conjunction with the Microsoft SMS documentation.
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Chapter 1: 

Lan Script Essentials

This chapter introduces Lan Script and its basic operation, and provides
an overview of the procedure for distributing software to the workstations
and servers on your network.

This Chapter Contains

• Overview   1.2

• Starting Lan Script   1.5

• The Lan Script Main Screen   1.7

• Editing Screen Fonts   1.16

• Determining Whether a File Has Been Upgraded   1.17

• Excluding Files   1.20

• Ending a Lan Script Session   1.21

• Using Help   1.24

• Helpline   1.25
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Overview

The procedure for distributing software to your workstations by means of scripts involves four
basic stages:

1. Generating scripts containing the distribution instructions.

2. Editing the scripts (optional).

3. Uploading the scripts to Microsoft Systems Management Server (SMS).

4. Distributing the software to your workstations using Microsoft SMS.

Generating Scripts

Lan Script uses a wizard to guide you step by step through the script generation procedure.

By taking a snapshot of your system, prompting you to install the software to be scripted, and
then taking a second snapshot, Lan Script identifies the changes made to the system by the
installation of your software. These are used as the basis for the construction of the scripts.

The elements monitored include the files on your workstation (additions, deletions and
upgrades) the directory structure, the contents of several key system files (e.g.
AUTOEXEC.BAT, CONFIG.SYS and all INI files) and the System Registry.

Three scripts are generated by Lan Script for each package:

• An upload script, which contains the instructions required to upload the scripts and
package details to Microsoft SMS.

• An installation script, which contains instructions required by Microsoft SMS to
install the software on the network servers and workstations.

• An uninstallation script, which contains instructions for subsequently removing the
software from the servers and workstations, if required.

We recommend that specific scripts are created for use on the Windows NT and Windows
95 platforms, and that you only use a script on the platform on which it was created.
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Editing the Scripts

When you have created the scripts, you are presented with a workbench from which you can
manually edit the scripts, if you require. The workbench contains four windows which have the
following contents:

• Scripts window
The upload, installation and uninstallation scripts.

• Monitored Changes window
The pre-installation and post-installation snapshots, and the changes identified between
the two.

• System Registry window
Additions and deletions made to the configuration of your system by the software
installation.

• Package window
General details about the package to be distributed.

It is possible to edit this information in order to customise the installation of the software
package according to your needs.

Uploading the Scripts to Microsoft SMS

The next stage is to upload the scripts and associated files to Microsoft SMS. Lan Script
forwards a range of information that you would usually have to enter manually, including
general package details, the source directory and Microsoft SMS inventory details.

Lan Script also forwards the platform that the package can be distributed to, i.e. Windows
NT or Windows 95.

Again, a wizard guides you through the procedure. The wizard automates:

1. Creating a package directory, and copying the files needed to that directory.

2. Creating and configuring the package within Microsoft SMS.

Once the script has been uploaded to Microsoft SMS, you can test that it works correctly
before you use it to install the package across the network. The testing routine checks the
installation script by running it to install the package on your local workstation.
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Distributing the Package to Your Workstations

The final stage is to distribute the package to your network servers and workstations. This is
carried out from Microsoft SMS.

To schedule a package for distribution, all you have to do is drag and drop the package onto
the sites, servers and/or workstations it is to be installed on, and confirm the schedule details.

Once a distribution job has been scheduled, you can use Microsoft SMS to monitor its
progress.

The Lan Script install client generates a status MIF for each distribution to a workstation or
server, indicating the success or otherwise of the distribution.

Should a job fail, Lan Script provides a rollback function to ensure that all servers and
workstations function in the same way as they did prior to the installation. In this case, the
status MIF provides further information indicating the reason for the job failing and whether a
rollback was carried out on each workstation affected. This enables you to make the
appropriate corrections, so that the job can be rescheduled.
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Installing Lan Script

Full instructions for installing Lan Script on your server and client workstation are provided in
Appendix A.

Starting Lan Script

To start Lan Script, select the ABC Lan Script icon from the Program Manager or Start Menu
on your client workstation. The following banner is displayed as Lan Script is loaded:

Shortly afterwards, this banner closes.

The first time you launch Lan Script, you are taken straight to the Lan Script Main Screen
(see page 1.7).

If you have previously used Lan Script on the workstation, and have created a script, the
Welcome window is displayed:
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The options available from this window are:

• Open “Script Name”
Reloads the last installation script created

• Create New Package
Starts the Create Package wizard, used to create a new script (see chapter 2).

• Create an Empty Script
Generates an empty script. You can then use the script editor to type in the script
commands in the conventional way (see chapter 3).

• Help Contents
Loads the Contents page of the Lan Script on-line help.
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The Lan Script Main Screen

The following illustration identifies the different areas of the Lan Script screen.

Menubar. Click on a Toolbar. Click on a
menu name to open button to choose a

that menu. command quickly.

status bar.

These different screen areas are explained on the following pages.

    Help assistant.

Main screen area, in
which the four windows
showing the script and
package details
generated are shown.
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The Menubar

The options available from the pull down menus are summarised below and on the
following pages. (The Window menu is not covered here, as it contains the
standard Windows options). A page reference is provided for each option,
indicating where detailed information can be found in this guide.

The File Menu

Option Used to ... See page ...

New Package... Generate a new installation script. 2.4

Open Package... Open the last installation script created. 3.2

Create Empty Generate an empty script. 1.6
Script...

Test Install Script Test an installation script that has been 4.7
uploaded to Microsoft SMS before it is
used to install the package across the
network.

Rebuild Script Files Regenerate script files after changes have 3.13
been made.

Upload Package Upload scripts and package details to 4.3
to SMS... Microsoft SMS, ready for distribution to

your servers and workstations.

Exit Exit Lan Script. 1.21
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The Edit Menu

The options available from the Edit menu vary, in order that they are applicable to the task you are carrying out,
and whether you are using the 16 or 32 bit version of Lan Script.

Generally, the Edit menu contains the following options:

Option Used to ... See page ...

Cut Cut the highlighted text to the clipboard 3.25
when editing a script file.

Copy Copy the highlighted text to the clipboard 3.25
when editing a script file.

Paste Paste the text held on the clipboard to the 3.26
cursor position when editing a script file.

Find Search for specific text when editing a 3.26
script file.

Find Next A ‘Find Next’ option is also available 3.27
to search for the next occurrence of the text
string specified using the Find option.

Replace Replace a specified text string, e.g. a word 3.27
or several words, with another specified text
string.
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When the System Registry window is displayed, the Edit menu contains the following options:

Option Used to ... See page ...

New Key Create a new key, as a subordinate 3.8
of the highlighted key.

Delete Key Delete the highlighted key, and all of 3.8
its subordinates.

When the Registry window is displayed, the Edit menu contains the following options:

Option Used to ... See page ...

Registry Keys Display a submenu containing options 3.21
you can use to maintain the System Registry
‘key’ details included in the script.

Registry Values Display a submenu containing options 3.21
you can use to maintain the System
Registry ‘values’ included in the script.

When you are using the Monitored Changes window to amend the changes identified to directories,
the Edit menu contains the following options:

Option Used to ... See page ...

Insert Item into Insert a directory to the list of those 3.12
Removed List to be removed during the installation.

Insert Item into Insert a directory to the list of those 3.12
Added List to be added during the installation.
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The Tools Menu

Option Used to ... See page ...

Options Displays a window containing tabs
you can use to:

• Edit the font, style and point size 1.16
of the details displayed in the
Scripts and Monitored Changes
windows.

• Specify whether file versions 1.17
are to be checked when
determining whether a file is
deemed to have been upgraded
by the software installation.

• List any specific files that are 1.20
to be excluded from scripts
created.

• List any general file types that 1.21
are to be excluded from scripts
created.
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The Help Menu

Option Used to ... See page ...

About Display program, copyright and license
information.

Help on Help Display general information about the use
of the on-screen help facility.

Contents Display general on-screen help. 1.24

Syntax Help Display help on the use of the scripting 1.24
commands available when editing scripts.
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The Toolbar

You can use the toolbar for quick access to commonly used commands.

" If you pause the mouse cursor over a button, a ToolTip is displayed summarising the
function of the button.

Button Used to ... Equivalent Menu option See page ...

Generate a new installation
script.

New Package... from the
File pull down menu.

2.4

Open the last script created. Open Package... from the
File pull down menu.

3.2

End your current ABC Lan
Script session.

Exit from the File pull
down menu.

1.21

Cut information to the clip-
board when editing a script
file.

Cut from the Edit pull
down menu.

3.25

Copy information to the
clipboard when editing a
script file.

Copy from the Edit pull
down menu.

3.25

Paste the text held on the
clipboard to the cursor
position when editing a script
file.

Paste from the Edit pull
down menu.

3.26

Search for text when editing a
script file.

Find from the Edit pull
down menu.

3.26
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Button Used to ... Equivalent Menu option See page ...

Upload scripts you have
created to Microsoft SMS.

Upload Package to SMS...
from the File pull down
menu.

4.3

Test the install script before it
is used to install the package
across the whole network.

Test Install Script from the
File pull down menu.

4.7

Regenerate the script files
after editing the changes
identified.

Rebuild Script Files from
the File pull down menu.

3.13

Turn the Help Assistant Bar
On and Off.

None. 1.15
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The Help Assistant Bar

The help assistant bar below the toolbar provides summary help about the screen or window
you are currently at:

Context-sensitive help. If more than 1 line
of help is available,
click here to scroll.

The Status Bar

The status bar at the bottom of the screen provides details about the process that Lan Script is
currently carrying out:

A description of the current
processing being undertaken.
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Editing Screen Fonts

Lan Script provides a facility to change the font, style and point size of the text displayed in
the Scripts window, Monitored Changes window (16 bit Lan Script) and File Monitoring
window (32 bit Lan Script). See Chapter 3 for details about these windows.

If you are using the 16 bit version of Lan Script, follow the steps below to change the screen
font in these windows:

1. Select Options...from the Tools pull down menu.

2. The View tab is displayed:

3. Select the font, size and style you require.
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If you are using the 32 bit version of Lan Script, follow the steps below to change the screen
font in these windows:

1. Select Options...from the Tools pull down menu.

2. The View tab is displayed:

3. Click on  to display the following font selection window:

4. Select the font, style and size you require.
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Determining Whether a File Has Been Upgraded

By default, Lan Script determines whether a file has been upgraded by a software installation
by checking its creation date and time, and its size. If any of these details have changed then
the file is deemed to have been upgraded.

You have the option of also checking each file’s version stamp to detect changes to version
numbers. (Whilst this provides a more thorough check, it may have a significant effect on the
time it takes to generate the scripts.)

To incorporate version stamp detection into the file comparison routine, follow the steps below:

1. Select Options...from the Tools pull down menu.

2. Select the Snapshots tab. The appearance of this tab depends on whether you are using
the 16 bit or 32 bit versions of Lan Script:
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3. Click on the Get File Version Information box.
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Excluding Files and File Types

Lan Script enables you to list specific files and/or general file types that are not to be included
in scripts created. For example, it is unlikely that you would want to include swap files or
temporary files that are created between the pre-installation and post-installation snapshots
being taken, so you would usually want to exclude these.

To exclude specific files:

1. Select Options...from the Tools pull down menu.

2. Select the Excluded Files tab. The appearance of this tab depends on whether you are
using the 16 bit or 32 bit versions of Lan Script:
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3. Use the  and  buttons to maintain the list of excluded files.

To exclude general types of files:

1. Select Options...from the Tools pull down menu.

2. Select the Excluded Extensions tab. Again, the appearance of this tab depends on whether
you are using the 16 bit or 32 bit versions of Lan Script:
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3. Use the  and  buttons to maintain the list of excluded file types.

You specify the types of files to be excluded by their extensions. For example, to exclude
temporary files, you would need to exclude files with extension ‘.TMP’.
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Ending a Lan Script Session

To end a Lan Script Session:

• Select Exit from the File pull down menu.

-or-

• Click on .

"
Lan Script is closed down automatically when you suspend the Create Package Wizard.
See page 2.16 for further details.
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Using Help

In addition to the summary help available from the help assistant bar (see page 1.15), Lan
Script provides a range of further help facilities. These are described below.

The Help Facility

Detailed on-line help is available, covering all aspects of the use of Lan Script.

There are two ways available to call the help:

• Select Contents from the Help pull down menu to display the first page of on-line help.
You can then either scroll through the help one page at a time (in the same way that
you would browse a book) or access a specific topic you require by:

 - Selecting it from the graphical Table of Contents.

 - Clicking on the Search tab, to display the alphabetical help index, from which 
you can choose the topic you require help on.

 - Clicking on the Find tab to display the help that includes a specific word.

• Get context-sensitive help as you work by pressing . For example if you press 
when you are at the Package window, information is displayed about the package
details generated.

When the help topic you require is displayed, some words are shown in green. These are
hypertext links. Clicking on these words provides a jump to a help topic associated with those
words. This enables you to navigate around the help system quickly.

Syntax Help

The syntax help facility gives information regarding the correct use of the scripting commands
used when editing script files. (A reference of these commands is provided in Appendix B:
Scripting Commands.)
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Helpline

If you are unsure about the correct operation of Lan Script, a technical support Helpline is
available. The phone or fax number you should call depends on where you are calling from.
These are indicated below and overleaf.

" The Helpline is available free of charge for a period of 90 days after we receive your
registration card. Support will not be available unless this card has been received,
although we will accept a faxed copy providing the original is sent to us immediately
afterwards.

Before telephoning or faxing the Helpline, please make sure that you have checked the
following sources of information:

• The on-line help available.

• A README.TXT file, in the directory that holds the Lan Script system files. If this
file is present, it contains any information which became available after this guide was
produced. You can read this using any text editor, e.g. Windows Notepad.

Technical Support in the UK and Europe:

Tel: +44 (0) 1952 271001

Fax: +44 (0) 1952 271100
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Technical Support in North America:

Please contact your Account Manager for support on the following numbers:

Tel: 508 470 3999

Fax: 508 474 4478

Internet :

helpdesk@abcsystems.com



Chapter 2:

Generating Scripts

This chapter takes you through the stages involved in generating scripts for
Microsoft SMS.

This Chapter Contains

• Introduction   2.2

• Stage 1: Start The Wizard   2.4

• Stage 2: Enter Package Details   2.6

• Stage 3: Locate The Installation Program (Optional)   2.7

• Stage 4: Select The Directories and Files To Monitor   2.8

• Stage 5: Select System Registry Changes   2.11

• Stage 6: Including The Package In The Microsoft SMS Inventory   2.13

• Stage 7: Take the Pre-Installation Snapshot   2.14

• Stage 8: Install the Package   2.16

• Stage 9: Customise/Adjust the Installation (Optional)   2.18

• Stage 10: Take the Post-Installation Snapshot and Build The Scripts   2.19

• Stage 11: Check Common Components   2.23

• Stage 12: Complete The Procedure   2.26
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Introduction

This chapter explains the procedure for creating installation scripts for Microsoft SMS.

Lan Script uses the Create Package wizard to guide you step by step through the script
creation procedure. At each stage, you are prompted to enter information or make a selection at
a window. All of the windows offer three standard options:

to continue on to the next stage.

 to return to the previous stage, to look at the details entered and amend them if
required.

to cancel the script creation procedure.

The wizard guides you through 12 stages:

Stage 1: Start The Wizard
Start the Create Package wizard, and check that there are no external processes
running that may interfere with the script creation. See page 2.4.

Stage 2: Enter Package Details
Enter basic information about the script you are creating. See page 2.6.

Stage 3: Locate The Installation Program
Enter or search for the path and filename of the installation program for the software
you are creating a script for. See page 2.7.

Stage 4: Select Additional Directories and Files To Monitor
Select any directories and files that are to be monitored during the script creation
process, in addition to the standard directories and files that are monitored by default.
See page 2.8.

Stage 5: Specify System Registry Changes
Choose whether changes made to the System Registry are to be incorporated into the
script, and if so, choose the keys to be scanned. See page 2.11.
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Stage 6: Indicate Whether Microsoft SMS Inventory Inclusion Is Required
Choose whether the package you are scripting is to be included in the Microsoft SMS
inventory of software. See page 2.13.

Stage 7: Take the Pre-Installation Snapshot
Capture the system details prior to the installation of the application. See page 2.14.

Stage 8: Install the Package
Carry out the normal procedure for installing the software to be scripted. See page
2.16.

Stage 9: Customise/Adjust the Installation (Optional)
Tailor the software installation specifically for your environment, if required. See
page 2.18.

Stage 10:Take the Post-Installation Snapshot and Build The Scripts
Capture the system details following the installation/customisation. See page 2.19.

Stage 11:Check Common Components
Specify any of the Microsoft common components used by Lan Script that are not to
be appended to the script. See page 2.23.

Stage 12:Complete The Procedure
Close the wizard or start the upload procedure. Details of the scripts and package
details created are displayed on screen. See page 2.26.
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Stage 1: Start The Wizard

Prior to commencing the creation of a script, you should prepare your machine:

• Scripting a New Software Installation
If you are creating a script for a new software installation, we advise that you use a
‘clean’ machine. That is, the only software installed on the machine you are using
should be the operating system and Lan Script. This ensures that the script contains
only the changes that are a result of the software installation, and are not confused
with changes made to files by other software that you may use.

• Scripting a Software Upgrade
If you are creating an installation script for a software upgrade, you should install the
original version of the software, i.e. the version that is to be upgraded.

You should then select New Package... from the File pull down menu, or click on , to start
the Create Package Wizard.

If you have previously used Lan Script to create scripts, the following window is displayed:

Only one script can exist on your machine at a time. If the previous script is no longer
required, i.e. it has been completed and uploaded to Microsoft SMS, or you want to discard it,
then click  to continue. The previous script will then be overwritten with the new one
you create.

Alternatively, click on  to cancel the script creation procedure, leaving the previous
script intact.
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If you choose to continue, the wizard’s opening window is displayed:

If you have any external applications on your machine, it is essential that they are closed
throughout the script creation process. This includes any background processes or screen
savers. If any processing takes place other than the installation of the software being scripted,
this will result in extraneous information being added to the scripts when they are created.

Providing all applications, background processes and screen savers are closed, click on 
to continue.
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Stage 2: Enter Package Details

Use the following window to enter general details about the software you are creating a script
for:

Enter the name of the software that you are creating installation scripts for, and any relevant
information about it, such as the version number and any miscellaneous information relating to
the installation.

Click on  to continue.

" The package name is also used as the directory name in SMS_SHR to which the package is
uploaded.
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Stage 3: Locate The Installation Program (Optional)

Next, locate the installation program for the software you are creating a script for.

If you know the path and name of the installation program, type in the details. (UNC paths are
also acceptable.)

If you do not know this information, click on the  button at the right of the field to browse
your directory structure for the program.

Click on  to continue.

" You do not have to enter a program name. If you leave this field blank, the wizard
continues up to and including the pre-installation snapshot (stage 7) and suspends the
procedure. You may want to do this, for example, to create a script that makes adjustments
to workstations, as opposed to installing software on them.
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Stage 4: Select Additional Directories and Files To Monitor

The next window lists the standard directories and files that are monitored during the script
creation process:

Usually, the directories and files listed will be the ones that need to be monitored. Providing
this is the case, click on  to accept these and continue to the next stage.

Alternatively, you can:

• Select additional directories to monitor. You would do this if you know that the
installation program writes files to drives/directories other than C:\. See the next page
for details.

• Select additional files to monitor. By default, Lan Script detects any new files added
and existing files changed within the range of directories selected. You can maintain
this list if you require, by selecting additional files from other directories, or deleting
files from the list that you do not want to monitor. See page 2.10.
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Selecting Additional Directories to Monitor

To specify directories that are to be monitored in addition to C:\, click on
. The Additional Directories window is displayed:

The left hand side of this window is used to locate additional directories to monitor. The right
hand side shows the directories currently selected for monitoring.

To add a directory to the list of those selected for monitoring, highlight it in the left hand
window and click on . (Alternatively you can double click on the directory.) It then appears
in the right hand window.

To remove a directory from the list of those being monitored, highlight it in the right hand
window and click on  (or double click on the directory). It is then deselected.

" You cannot remove the C:\ drive - this must always be monitored.

When the directories selected are as required, click on  to return to the main window,
and then click on  to continue the wizard.
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Selecting Additional Files to Monitor

To specify files that are to be monitored in addition to AUTOEXEC.BAT, CONFIG.SYS, *.INI
and *.GRP, click on . The Additional Files window is displayed:

The left hand side of this window is used to locate the additional files to monitor. The right
hand side shows the files currently selected.

To add a file to the list of those selected for monitoring, select it by choosing the drive and
directory in which it is located, highlighting it in the bottom left hand window, and clicking on

. (Alternatively, you can double click on the file.) It then appears in the right hand window.

To remove a file from the list of those being monitored, highlight it in the right hand window
and click on  (or double click on the file). It is then deselected. You can add or remove
several files at a time by following the standard Windows conventions, i.e. use the  key to
select several individual files, or the  key to select a range of files.

"
You cannot remove the AUTOEXEC.BAT, CONFIG.SYS, WIN.INI or SYSTEM.INI files.
These are always monitored.

When the files selected are as required, click on  to return to the main window, and
then click on  to continue the wizard.
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Stage 5: Specify System Registry Changes

The next stage is to specify whether you want changes made to the System Registry
incorporated in the script. The way you do this differs for the 16 bit version of Lan Script (see
below) and the 32 bit version (see the next page).

The following window is displayed for you to specify whether you want System Registry
changes incorporated in the script:

The default selection is Yes - Scan Registry, to monitor the System Registry changes. We
recommend that you retain this setting.

The bottom half of the window shows the keys that comprise the Registry. This can be used to
specify any particular keys that are not to be monitored.

To open a key, showing its subordinate keys, click on its description. Clicking on its
description again closes the key.

A cross against a key indicates that it has been selected for monitoring. To exclude a key (and
its subordinate keys) from monitoring, click on its check box. The cross is then removed to
signify that it has been excluded. Clicking on its check box again reselects the key for
inclusion. When the keys to be monitored are selected, click on  to continue.

" Under normal circumstances, we recommend that you monitor all keys in the Registry.
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The following window is displayed for you to specify whether you want System Registry
changes incorporated in the script:

The default selection is Yes - Scan Registry, to monitor the System Registry changes. We
recommend that you retain this setting.

The bottom half of the window shows the keys that comprise the Registry. This can be used to
specify any particular keys that are not to be monitored.

To open a key, showing its subordinate keys, left click on it. Left clicking again closes the key.

A check mark (9) against a key indicates that it has been selected for monitoring. To exclude
a key (and its subordinate keys) from monitoring, right click on it. The check is then removed
to signify that it has been excluded. Right clicking again reselects the key for inclusion. When
the keys to be monitored are selected, click on  to continue.

" Under normal circumstances, we recommend that you monitor all keys in the Registry.
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Stage 6: Indicate Whether Microsoft SMS Inventory Inclusion Is Required

Microsoft SMS can provide an inventory of the software which is installed on your network. It
does this by detecting the presence of key files that are specific to the software packages
installed.

The following window is displayed for you to specify whether you wish to include the package
you are installing in the Microsoft SMS software inventory:

If you select Yes - I wish to monitor this package, you are prompted to specify which files are
to be used to identify this package later in the wizard (see page 2.20).

Click on  to continue when you have made your selection.
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Stage 7: Take the Pre-Installation Snapshot

The wizard is now ready to take the pre-installation snapshot. A reminder is provided that all
other applications, screen savers and background processes must be closed:

Click  to continue.

With the 16 bit version of Lan Script only, a further confirmation window is displayed prior
to the pre-installation snapshot commencing:

Providing all applications, screen savers and background processes have been closed, click
on  to start the snapshot procedure.
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A window is displayed showing the progress as the pre-installation snapshot is taken:
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Stage 8: Install the Package

After completing the pre-installation snapshot, the following window is displayed prompting
you to start installing your software package:

If you selected a program to run, check that the name of the installation program is correct. If
it is not, click on  to select the correct file.

You should then click on the appropriate button for the action you want to take:

Run Runs the installation program whilst Lan Script remains open
in the background. When the installation is complete, you are
taken straight into the post-installation snapshot (stage 10).

This is the quickest method, which you should choose if you
do not need to customise the installation.

 Suspend Wizard Suspends the Create Package wizard, closes Lan Script, and
 and Run runs the installation program. When the installation is

complete, you can then customise the installation (stage 9).
When you next start Lan Script, the wizard restarts at stage
10.



Chapter 2: Generating Scripts

2.17

 Suspend Wizard Closes Lan Script without running the installation program.
You must then run the installation manually from Windows,
and customise it if required (stage 9). When you next start
Lan Script, the wizard restarts at stage 10.

Continues the post-installation snapshot, without running the
installation program. (You would not usually want to do this.)

Usually, you will be able to use Run. However, the danger of using this method is the
possibility that the software installation will attempt to use Microsoft common components,
e.g. DLL files that are already loaded into memory. In this case, a conflict will occur and the
software installation will display an error message, giving you the options to abort, retry or
ignore.

The Suspend Wizard option eliminates the possibility of such conflicts, as Lan Script will not
have these files in memory during the software installation.

The approach that we recommend is to try using Run. If this results in a conflict, select the
‘abort’ option and then restart the script creation procedure, this time suspending the wizard
and running the installation manually.
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Stage 9: Customise/Adjust the Installation (Optional)

When you have completed the installation, you can then customise the software to configure it
specifically for your environment. These changes will then be reflected on all workstations to
which this software package is distributed. You can:

• Adjust the software configuration. For example, change the settings or preferences
specified in the application. To do this, you simply open the software application,
make the changes required, save them, and close the application.

• Add additional files that are to be distributed with the software. For example, if the
script is for a word processor, you may want to add template files that are to be used
in conjunction with it. To do this, copy the files required to the appropriate directory.

• Delete files that you do not want to be distributed. To do this, delete the appropriate
files from the installation.

• Perform additional installations if you want to create a full workstation package. To
do this, install all of the software to be loaded onto the workstations.

• Make manual adjustments. In addition to creating software installation scripts, Lan
Script can be used to generate scripts that make adjustments to workstations. This is
done by not specifying an Install Program at stage 3. In this case, you should make
the adjustments to be scripted now.

To customise the installation, you should have selected Suspend Wizard and Run or
Suspend Wizard at stage 8 to suspend the wizard. You can then customise the software or
make adjustments as required.

When you have completed the customisation/adjustments, start Lan Script again to proceed
with the wizard at stage 10.

" An alternative (but more complicated) way of customising the software is to manually edit
the scripts. See Chapter 3 for details.

" You can take as long as you like, and reboot your machine if you require, whilst carrying
out the customisation/adjustments. There are no time constraints.
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Stage 10: Take The Post-Installation Snapshot and Build The Scripts

When you have installed the software and carried out any customisation required, the wizard
carries out the following tasks:

• Takes the post-installation snapshot.

• Builds the scripts by comparing this with the pre-installation snapshot.

If you terminated or suspended the wizard at either Stage 8 or 9, the post-installation snapshot
commences the next time you restart Lan Script.

If you did not terminate or suspend Lan Script, the post-installation snapshot commences when
you click on  at Stage 9.

With the 16 bit version of Lan Script only, the following confirmation window is displayed
prior to the post-installation snapshot commencing:

Providing all applications, screen savers and background processes have been closed, click
on  to start the post-installation snapshot.
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A window is displayed showing the progress as the post-installation snapshot is taken:

When the snapshot is complete, Lan Script proceeds to build the scripts, by comparing the
post-installation snapshot with the pre-installation snapshot taken at stage 7.

Selecting Files for the Microsoft SMS Package Inventory

As part of the build process, the wizard assembles the details required by Microsoft SMS. If
you chose to include the package in the software inventory (see stage 6), a window is displayed
for you to specify the files that Microsoft SMS should look for to detect the presence of the
software package.

" If you chose not to include the package in the software inventory at stage 6, you can
subsequently reverse this selection, i.e. include the package in the inventory. This is done
from the Inventory tab of the Package window (see page 3.5). You can also use this tab to
adjust the existing selection.
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If you are using the 16 bit version of Lan Script, the following window is displayed for you
to specify the files that Microsoft SMS should look for:

If you are using the 32 bit version of Lan Script, you specify these files in the following
window:
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The information shown and the procedure for using these windows is the same for both the 16
bit and 32 bit versions.

In both cases, the top half of the window lists the files that were added to the hard disk by the
installation routine. The bottom half is used to specify which of these files Microsoft SMS
should use to detect the presence of the application on workstations.

To add a file to the list of those used to detect the application, highlight it and click on .
(Alternatively, you can double click on the file.) It then appears in the bottom half of the
window.

" The  button can be used to add further files to the top half of the window, if
you want to specify files other than those added by the installation routine.

To remove a file from the list, highlight it in the bottom half and click on  (or double click
on the file). It is then deselected.

You can add or remove several files at a time by following the standard Windows conventions,
i.e. use the  key to select several individual files, or the  key to select a range of files.
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Stage 11: Check Common Components

Microsoft common components are files that may be used by more than one application.
Potentially, they may cause a problem when creating a script if the software you are scripting
uses the same common components as Lan Script. (The danger is that your installation
program may detect their presence on your machine, and choose not to install them. In this
case, they will not be included in the normal script created, which may result in errors when
your users try to run the software you are installing.) To avert this possibility, the wizard sets
each common component used by Lan Script for appending to the installation script. This
means that they will always be available to the software you are installing, even though they
may not be required.

The Microsoft common components that Lan Script will append to the installation script are
listed on screen. You have the choice to leave these intact, in which case they will be appended, or
to cancel the setting of individual components.

0
You should only remove components that you are certain are not required by the software
installation.
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The common components are listed in the following window:

A cross against a component indicates that it has been selected for appending to the script. You
can cancel this setting if you require, by clicking on the cross to remove it.

(Right clicking on this list displays a popup menu that you can use to select/deselect all
components.)

Click on  when the settings are as required.
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The common components are listed in the following window:

The check mark ( ) against a component indicates that it has been selected for appending to
the script. You can cancel this setting if you require, by left or right clicking on the check
mark.

Further information is available for each of the components, by clicking on the plus sign (+) to
the left of the check mark.

Click on  when the settings are as required.
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Stage 12: Complete The Procedure

A window is displayed indicating that the Create Package wizard has now completed the script
generation procedure. The window displayed depends on whether you are using the 16 bit or
32 bit versions of Lan Script:
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Click on:

 or To return to the Lan Script main screen, which now contains
four windows showing the scripts and package details generated.
The details shown in these windows, and the options available
for editing them, are described in Chapter 3.

 or To start the Upload wizard. You should select this option if you
want to proceed with the uploading of the scripts to Microsoft
SMS without viewing or editing them. The upload procedure is
described in Chapter 4.
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Chapter 3: 

Editing Scripts

This chapter describes the details created by the script generation procedure, and
explains how you can manually edit this information if you require. Separate
instructions are provided for users of 16 bit and 32 bit Lan Script.

This Chapter Contains

• Scripts Generated by 16 Bit Lan Script   3.2

• Scripts Generated by 32 Bit Lan Script   3.15

• Script Editing Commands   3.25
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Scripts Generated by 16 Bit Lan Script

This section looks at the scripts generated by 16 bit Lan Script, and explains how you
can manually edit this information if you require. Details about the scripts generated by
32 bit Lan Script are provided in the next section, beginning on page 3.15.

When the Create Package wizard has completed the script generation procedure, the Lan
Script Main Screen shows the scripts and package information generated:

Details are held in four windows:

• Package window
Contains three tabs that you use to:

 - View general information about the package.

 - Specify the files selected for Microsoft SMS inventory monitoring.

 - Configure the way the installation script operates when it is run.

 See page 3.4.
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• System Registry window
Shows the additions and deletions made to the System Registry. See page 3.7.

• Monitored Changes window
Contains three tabs which show the pre-installation snapshot, the post-installation
snapshot and the changes identified. See page 3.9.

 You can edit the details in the Changes Made tab if you require - see the discussion
below for details.

• Scripts window
Contains three tabs which hold the installation script, uninstallation script and upload
script created. See page 3.14.

 You can edit the details in all three of these tabs if you require - see the discussion
below for details.

What is the Best Way to Edit the Scripts?

There are two general ways available to edit the installation, uninstallation and upload scripts
generated:

• Method 1: Edit the scripts directly
From the Scripts window, you can edit the script commands directly. A summary of
the commands used for package scripting is provided in Appendix B.

• Method 2: Amend the changes that Lan Script has identified
An alternative to editing the actual scripts is to amend the changes Lan Script
identified between the pre-installation snapshot and the post-installation snapshot. This
is done from the Changes Made tab in the Monitored Changes window. You then
need to rebuild the script so that it is based on the updated changes, by selecting the
Rebuild Script Files option from the File pull down menu.

Both methods achieve the same results. The one you should choose depends on your script
editing experience and working preferences. Whilst method 1 is the quickest and most direct
way, it requires that you are familiar with the use of scripting commands. Method 2 eliminates
the use of the scripting commands, but requires that the scripts are rebuilt each time a change
is made.
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The Package Window

The Package Window contains general information about the package created. These details
are held in three tabs:

• Package Information

• SMS Software Inventory

• Installation Options

The Package Information Tab

The Package Information tab shows the details entered at stage 2 of the script generation
procedure (see page 2.6).

You cannot change the
package name.

You can change or add to
the comments recorded.
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The SMS Software Inventory Tab

If you chose to include the package in the Microsoft SMS software inventory (at stage 6 of the
script generation procedure, see page 2.13), then you will have specified the files to be used by
Microsoft SMS to detect the presence of the package (at stage 10 of the script generation
procedure, see page 2.19).

The SMS Software Inventory tab can be used to view the inventory files selected, and update
these if necessary.

To view or update the inventory files, click on . The Package Inventory
Monitoring window is displayed showing the inventory files currently selected. The details
shown in this window and the procedure for updating it are explained in the section Selecting
Files for the Microsoft SMS Package Inventory, page 2.20.
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The Installation Options Tab

The Installation Options tab can be used to configure the way the installation script operates
when it is run. You can specify:

• Whether a progress indicator is shown during the installation of the package on
workstations.

• Whether a backup of the key system files on each destination workstation is required.
If a backup is selected, the AUTOEXEC.BAT, CONFIG.SYS, *.GRP and *.INI files
are backed up to a local drive automatically before the installation commences. These
are then available to be restored if necessary.

To select a progress indicator, insert a
cross here.

If you choose a progress indicator, you
can specify a message here that is shown
whilst the indicator is displayed.

To automatically backup the system files
on the destination workstations, insert a
cross here. This enables you to perform a
rollback should a job fail (see the section
Unsuccessful Jobs and the Rollback
Function, page 5.12 for details).
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The System Registry Window

At stage 5 of the script generation procedure (see page 2.11), you specified whether you
wanted changes made to the System Registry incorporated into the script.

If you indicated that you did, the additions and deletions made to the System Registry are
shown in the Registry Window:

This window shows the keys that comprise the System Registry. The Deletions tree shows the
data to be removed from workstations. The Additions tree shows the data to be added to
workstations.

As you highlight each key, the Value bar at the top of the screen shows its current value.
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Maintaining The System Registry Keys

To maintain the System Registry key additions/deletions that are to be included in the script,
either select Registry Keys from the Edit pull down menu, or right click in the System Registry
window. The following menu is displayed showing the options available to maintain the keys:

New Key Creates a new key, as a subordinate of the highlighted key.

Delete Key Deletes the highlighted key, and all of its subordinates.

" This menu is context-sensitive so that the options are only available when relevant, e.g. New
Key is not available when the HKEY_CLASSES_ROOT key is highlighted because you
cannot add values or keys under HKEY_CLASSES_ROOT.

Maintaining The System Registry Values

To maintain the System Registry value associated with a key, highlight it and enter the value
required in the Value bar at the top of the screen.
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The Monitored Changes Window

The Monitored Changes Window shows the changes Lan Script identified to the files and
directories that were monitored.

Monitored Files

If you click on a monitored file in the left pane, the contents of the file are shown in the right
pane:

The right hand side contains three tabs:

• Before Installation
The contents of the highlighted file prior to the installation, as identified by the
snapshot taken at stage 7 of the script generation procedure (see page 2.14).

• After Installation
The contents of the highlighted file following the installation, as identified by the
snapshot taken at stage 10 of the script generation procedure (see page 2.19).

• Changes Made
The changes Lan Script has identified as being made to the highlighted file, extracted
by comparing the pre-installation and post-installation snapshots.

Shaded files
were modified by
the installation.

White files
remained
unchanged.
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Amending The Changes Identified to Files

You may want to edit the changes Lan Script identified to a file. For example, you may
identify a particular change made by the software installation that you do not want
incorporated into the scripts. To do this, click on the Changes Made tab. The changes
identified to the contents of the highlighted file are shown in the right pane:

Edit the changes identified as required.

After making the amendments required to the file changes, you should rebuild the scripts so
that they are based on these updated details. To do this, either:

• Select Rebuild Script Files from the File menu, or

• Click on 

The changes you have made are then incorporated into the script.

"
The details shown in the Before Installation and After Installation windows are for informa-
tion only. Whilst you can edit these, this will not have any effect if you rebuild the script.
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Directory Structure

If you click on the directory snapshot in the left pane, the changes made to the directories on
the drives monitored are shown in the right pane:

The top right hand window shows the subdirectories and files that were removed from the
monitored drives. The bottom right hand window shows the subdirectories and files that were
added to or changed on the monitored drives.

As with the monitored files, you can view before and after snapshots of the directory structure.
To do this, click on the appropriate button at the top of the screen:

Displays the contents of each of the monitored drives prior to the
installation, as identified by the snapshot taken at stage 7 of the script
generation procedure (see page 2.14).

Displays the contents of each of the monitored drives following the
installation, as identified by the snapshot taken at stage 10 of the script
generation procedure (see page 2.19).

" It may take several minutes to display a before or after snapshot.
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Amending The Changes Identified to Directories

The following functions are available to amend the changes identified to the highlighted
directory:

Buttons

Adds a file to the list of those currently focused.

Adds a directory to the list of those currently focused.

Deletes the highlighted file/directory, and all of its subordinates if
applicable.

Context Sensitive Menu

The functions provided by the three buttons are also available from a context sensitive menu. If
you right click on either of the two right hand window panes, the following submenu is
displayed.

These three options correspond to the buttons described above.

Edit Menu

When the directory snapshot is highlighted, the Edit pull down menu provides the following
options:

Insert Item Into Inserts a directory to the list of those to be removed during the
Removed List installation.

Insert Item Into Inserts a directory to the list of those to be added during the installation.
Added List
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After making the amendments required to the directory changes, you should rebuild the scripts
so that they are based on the updated details. To do this, select Rebuild Script Files from the
File menu. The changes you have made are then incorporated into the script.

" You can change the font in which the text shown in the right hand side of the Monitored
Changes window is displayed, by selecting Options from the Tools pull down menu. See the
section Editing Screen Fonts, page 1.16, for details. (The left hand side is shown in the
default Windows font.).
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The Scripts Window

The Scripts window contains three tabs which hold the install script, deinstall script and
upload script created:

" You can change the font in which the text shown in this window is displayed, by selecting
Options from the Tools pull down menu. See the section Editing Screen Fonts, page 1.16,
for details.

You can edit the script commands shown in these windows directly.

0 If you change one of the scripts, the other two may also need to be changed.

The functions available to help you edit the scripts are described in the next section, Editing
Scripts.

A summary of the commands used in the scripts is provided in Appendix B.
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Scripts Generated by 32 Bit Lan Script

This section looks at the scripts generated by 32 bit Lan Script, and explains how you
can manually edit this information if you require. Details about the scripts generated by
16 bit Lan Script are provided in the previous section, beginning on page 3.2.

When the Create Package wizard has completed the script generation procedure, the Lan
Script Main Screen shows the scripts and package information generated:

Details are held in four windows:

• Package window
Contains three tabs showing general package information, the platform that the
installation and uninstallation scripts are valid for, and the files selected for inventory
monitoring. Most of these details can be amended if required. See page 3.17.

• Registry window
Shows the additions and deletions made to the System Registry. See page 3.20.
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• File Monitoring window
Contains three tabs which show the pre-installation snapshot, the post-installation
snapshot and the changes identified. See page 3.22.

 You can edit the details in the Changes Made tab if you require - see the discussion on
the page opposite for details.

• Scripts window
Contains three tabs which hold the installation script, uninstallation script and upload
script created. See page 3.24.

 You can edit the details in all three of these tabs if you require - see the discussion on
the page opposite for details.

What is the Best Way to Edit the Scripts?

There are two general ways available to edit the installation, uninstallation and upload scripts
generated:

• Method 1: Edit the scripts directly
From the Scripts window, you can edit the script commands directly. A summary of
the commands used for package scripting is provided in Appendix A.

• Method 2: Amend the changes that Lan Script has identified
An alternative to editing the actual scripts is to amend the changes Lan Script
identified between the pre-installation snapshot and the post-installation snapshot. This
is done from the Changes Made tab in the File Monitoring window. You then need to
rebuild the script so that it is based on the updated changes, by selecting the Rebuild
Script Files option from the File pull down menu.

Both methods achieve the same results. The one you should choose depends on your script
editing experience and working preferences. Whilst method 1 is the quickest and most direct
way, it requires that you are familiar with the use of scripting commands. Method 2 eliminates
the use of the scripting commands, but requires that the scripts are rebuilt each time a change
is made.
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The Package Window

The Package Window contains general information about the package created. These details
are held in three tabs:

• Package Information

• Workstation Command Lines

• Inventory

The Package Information Tab

The Package Information tab shows the details entered at stage 2 of the script generation
procedure (see page 2.6).

You cannot change the
package name.

You can change or add to
the comments recorded.



ABC Lan Script

3.18

The Workstation Command Lines Tab

The Workstation Command Lines tab shows the platform that the scripts are valid for:

We recommend that you should only use a script on the platform it was created on. For this
reason, you should not change the settings displayed in this window.
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The Inventory Tab

If you chose to include the package in the Microsoft SMS software inventory (at stage 6 of the
script generation procedure, see page 2.13), then you will have specified the files to be used by
Microsoft SMS to detect the presence of the package (at stage 10 of the script generation
procedure, see page 2.19).

The Inventory tab can be used to view the inventory files selected, and update these if
necessary.

To view or update the inventory files, click on . The Package Inventory
Monitoring window is displayed showing the inventory files currently selected. The details
shown in this window and the procedure for updating it are explained in the section Selecting
Files for the Microsoft SMS Package Inventory, page 2.20.
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The Registry Window

At stage 5 of the script generation procedure (see page 2.11), you specified whether you
wanted changes made to the System Registry incorporated into the script.

If you indicated that you did, the additions and deletions made to the System Registry are
shown in the Registry Window:

The left pane shows the keys that comprise the System Registry. The Deletions tree shows the
data to be removed from workstations. The Additions tree shows the data to be added to
workstations.

The right pane shows the values to be added/deleted for the highlighted key.
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Maintaining The Registry Keys

To maintain the Registry key additions/deletions that are to be included in the script, either
select Registry Keys from the Edit pull down menu, or right click in the left pane. The
following menu is displayed showing the options available to maintain the keys:

Expand/Collapse Expands the highlighted key to show its subordinate keys. Selecting this
option again collapses the key, i.e. hides its subordinate keys.

New Key Creates a new key, as a subordinate of the highlighted key.

Delete Key Deletes the highlighted key, and all of its subordinates.

Maintaining The Registry Values

To maintain the Registry values that are to be included in the script, either select Registry
Values from the Edit pull down menu, or right click in the right pane. The following menu is
displayed showing the options available to maintain the values:

Edit Data Edits the data for the highlighted value.

New Value Adds a new value to the highlighted key.

Delete Value Deletes the highlighted value.

" The Edit menu is context-sensitive, e.g. you cannot add values under the
HKEY_LOCAL_MACHINE key.
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The File Monitoring Window

The File Monitoring Window contains three tabs:

• Before Installation
The pre-installation snapshot, taken at stage 7 of the script generation procedure (see
page 2.14).

• After Installation
The post-installation snapshot, taken at stage 10 of the script generation procedure
(see page 2.19).

• Changes Made
The changes that Lan Script has identified as being made by the installation, extracted
by comparing the pre-installation and post-installation snapshots.

" You can change the font in which the text shown in the right hand side of this window is
displayed, by selecting Options from the Tools pull down menu. See the section Editing
Screen Fonts, page 1.16, for details. (The left hand side is shown in the default Windows
font.)
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The left hand side of this window shows the directories and files that were monitored. The right
hand side shows the contents of the highlighted file before the installation, after the installation,
or the changes made to it by the installation (depending on which tab is currently selected).

The Changes Made window should be used to edit the changes Lan Script identified. You
should then rebuild the scripts so that they are based on these updated changes, by selecting the
Rebuild Script Files option from the File menu. For example, you may want to do this if you
notice a particular change made by the software installation that you do not want incorporated
into the scripts. By deleting the appropriate line from this window, and rebuilding the script,
this change will be removed from the scripts.

The details shown in the Before Installation and After Installation windows are for
information only. Whilst you can edit these, this will not have any effect if you rebuild the
script.
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The Scripts Window

The Scripts window contains three tabs which hold the installation script, de-installation script
and upload script created:

" You can change the font in which the text shown in this window is displayed, by selecting
Options from the Tools pull down menu. See the section Editing Screen Fonts, page 1.16,
for details.

You can edit the script commands shown in these windows directly.

The functions available to help you edit the scripts are described in the next section Editing
Scripts.

A summary of the commands used in the scripts is provided in Appendix B.
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Script Editing Commands

Both the 16 bit and 32 bit versions of Lan Script provide functions to help you edit the scripts
created, and search for words contained in the script. These are similar to the facilities
available with most standard word processing applications.

Cutting Text

Cutting text copies it to the Windows clipboard and deletes it from the script. This text can
then be ‘pasted’ (see Pasting Text on the next page) elsewhere in the same script, in another
script or in another Windows application.

To cut a section of text:

1. Highlight it.

2. Cut it by:

• Selecting Cut from the Edit pull down menu, or

• Entering the keyboard shortcut  + X, or

• Clicking .

Copying Text

Copying text writes it to the Windows clipboard and leaves it intact in the script. This text can
then be ‘pasted’ (see Pasting Text below) elsewhere in the same script, in another script or in
another Windows application.

To copy a section of text:

1. Highlight it.

2. Copy it by:

• Selecting Copy from the Edit pull down menu, or

• Entering the keyboard shortcut  + C, or

• Clicking .
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Pasting Text

Pasting inserts the current contents of the clipboard (which must be text) into the script, at the
current cursor position.

To copy a section of text:

1. Highlight it.

2. Paste it by:

• Selecting Paste from the Edit pull down menu, or

• Entering the keyboard shortcut  + V, or

• Clicking .

Finding Text

The find facility searches for and locates occurrences of text you specify.

To find text:

1. Open the Find box by:

• Selecting Find from the Edit pull down menu, or

• Entering the keyboard shortcut  + F, or

• Clicking .

2. Type the text you want to find. You can also specify whether you want to match the case
(upper or lower) or search up or down.

3. Click on .

Lan Script then locates and highlights the first occurrence, after the cursor position, of this
text.
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You can then locate the next occurrence of the text if you require. The way you do this depends
on whether you are using the 16 bit or 32 bit version of Lan Script:

Click on  again.

Either select Find Next from the Edit pull down menu, or press .

Replacing Text

The replace facility replaces occurrences of text you specify with different text.

To replace text:

1. Open the Replace box by:

• Selecting Replace from the Edit pull down menu, or

• Entering the keyboard shortcut  + R.

2. Type the text you want to replace, and the text you want to replace it with. You can also
specify whether you want to match the case (upper or lower).

3. Either:

• Click on  to locate the next occurrence or the text to be replaced. You can
then choose to click on  to replace this occurrence, or  to leave it
unchanged and find the next occurrence.

or

• Click on  to replace all occurrences of the text found in the script.
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Moving Text

The 32 bit version of Lan Script provides a facility to move a section of text to a different
position within the same script. To do this:

1. Highlight the text you want to move.

2. Drag it to the position in the script you want to move it to.
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Uploading Scripts to Microsoft SMS

This chapter explains how to upload scripts you have created to Microsoft SMS
and test that they work correctly.

This Chapter Contains

• Introduction   4.2

• Uploading Scripts   4.3

• Testing the Installation Scripts   4.7
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Introduction

When you have generated your scripts, and edited them if required, you can then:

• Upload the scripts and associated files to Microsoft SMS
A wizard guides you through the simple procedure for uploading the scripts.

• Test the installation script
This is an optional wizard that you can use to test that your installation script works
correctly before actually using it to distribute software.

The testing routine works by running the installation script to install the software on
your local workstation (i.e. the workstation you are running Lan Script on).

" Before you can test an installation script, you must have uploaded it to Microsoft
SMS, and have the Microsoft SMS Client installed on the test workstation.

When you have uploaded your scripts, and tested them if required, they are then ready to be
used for distributing the software to your workstations.
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Uploading Scripts

The wizard that you run to upload the scripts to Microsoft SMS carries out the following:

1. Creates a directory with the same name as the package in the share SMS_SHR.

2. Copies all the files needed to distribute the package to this directory.

3. Creates a package for the application and automatically imports this into Microsoft
SMS. The package includes the following details:

• Its name and any comments recorded (as entered at stage 2 of the script
generation procedure).

• The source directory in which the package is held.

• The command lines that run the automated installation and automated
uninstallation routines. (For 16 bit Lan Script these are: ‘INSCL16.EXE
INSTALL.INS’ and ‘INSCL16.EXE  DEINSTAL.INS’, respectively. For 32
bit Lan Script, they are: ‘INSCL32.EXE  INSTALL.INS’ and ‘INSCL32.EXE
DEINSTAL.INS’, respectively.)

• Access details.

• Inventory files, i.e. the files used by Microsoft SMS to detect the presence of the
package, (as entered at stage 6 of the script generation procedure).

• The 32 bit version of Lan Script also specifies the supported platforms to which
the package can be distributed.

" Further explanation about these package details is provided in the section Information
Lan Script Carries Forward to Microsoft SMS, page 5.5.
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To upload your scripts and associated files to Microsoft SMS, follow the steps below:

1. Select Upload Package to SMS ... from the File pull down menu, or click on .

2. The opening window of the Upload Wizard is displayed:

Click on .

The system then checks that you have SMS Client installed. Providing you have, you
can proceed with the upload. If you have not, a warning is displayed. In this case, you
must close down Lan Script and install SMS Client before you can continue.
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3. The next stage is to log on the SQL Server and access the Microsoft SMS database:

Enter your logon details in the usual way.

4. When you have successfully logged on to Microsoft SQL Server, Lan Script attempts to
connect to the ABC Lan Script service running on the SMS Server.

Providing the connection to the ABC Lan Script service is successful, the scripts and
associated files are automatically uploaded to the designated area on the Microsoft SMS
server. The wizard displays a series of messages to keep you informed of progress as the
scripts and files are uploaded.

If the server or service is not available, the following message is displayed:

In this case, click on  to close this window and investigate the cause of the
problem.
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5. When the upload is complete, you are prompted:

Click on:

 to shutdown the wizard and return to the Lan Script Main Screen.

-or-

 to shutdown the wizard and begin testing the script uploaded. This
has the same effect as selecting Test Install Script from the File pull
down menu. See the next page for details.

This completes the uploading procedure.
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Testing the Installation Scripts

Lan Script provides a wizard that you can use to test the last installation script that was
uploaded to Microsoft SMS. The wizard works by running the script to install the software on
your local workstation (i.e. the workstation you are running Lan Script on).

As part of the test installation, the wizard checks that:

• All source directories exist in Microsoft SMS, i.e. the upload was successful.

• The syntax of each command contained in the script is correct.

" Before you can test an installation script, you must have uploaded it to Microsoft SMS,
and have the Microsoft SMS Client installed on the test workstation.

To test the last installation script uploaded to Microsoft SMS, follow the steps below:

1. Remove the software that you installed on your local machine during the script generation
procedure (at stage 8, see page 2.16) by locating and deleting the appropriate files.

2. Select Test Install Script from the File pull down menu, or click on .

3. The opening window of the test wizard is displayed:

Click on  to start the test.
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4. The wizard then proceeds to run the script to install the software on your local PC. The
screen display indicates the success or otherwise of the installation.

If an error is detected, the message indicates the cause of the error, e.g.:

Providing no errors occur, the following message is displayed:

5. Close the wizard.

6. To complete the test, check that you can run the application and that all of the directories,
files and icons that you would expect exist.
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If the Test Fails

If the test shows that the package contains errors:

1. Resolve the problem by correcting the script command that caused the failure. (The
command being executed when the failure occurred is indicated in the error message
displayed, see the previous page.)

2. Upload the corrected script to Microsoft SMS.

3. Rerun the test.
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Chapter 5: 

Distributing Packages to Your
Workstations

This chapter explains how to use Microsoft SMS to distribute
packages generated using Lan Script to your workstations.

This Chapter Contains

• Introduction   5.2

• The Microsoft SMS Administrator Screen   5.4

• Information Lan Script Carries Forward to Microsoft SMS   5.5

• Scheduling a Package For Distribution   5.7

• Monitoring The Progress of a Job   5.10

• Unsuccessful Jobs and The Rollback Function   5.12

• The Procedure If a Job Fails   5.13
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Introduction

When you have uploaded your scripts to Microsoft SMS, and tested them if required, the
package is available for distributing to your network workstations. The distribution procedure
is carried out from Microsoft SMS.

In the same way that Lan Script automates and simplifies script generation, it also makes the
distribution procedure less complicated. It does this by automatically carrying forward to
Microsoft SMS a range of information that you would usually have to enter manually. The
details carried forward to Microsoft SMS about each package include:

• General details (its name and any comments recorded about it).

• The source directory.

• The platform it can be distributed to.

• Inventory details, so that the package is automatically included in the
Microsoft SMS software inventory.

This means that to schedule a package for distribution, all you have to do is:

1. Drag and drop the package onto the servers or workstations it is to be installed on.

2. Check the schedule details and, providing they are correct, confirm them.

Once a distribution job has been scheduled, you can use Microsoft SMS to monitor its
progress.

When carrying out any installation from Microsoft SMS there is the possibility of a failure,
which may result in workstations being left in a partially configured state. To avert the
possibility of workstations becoming unusable, Lan Script provides a rollback function. This
gives each user the option of restoring their machine, so that it functions the same way as it did
before the installation began.

Whenever a failure occurs, Lan Script communicates to Microsoft SMS the reason for the job
failing and indicates whether a rollback was carried out on each workstation affected. The
appropriate corrections should then be made and the job rescheduled.
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About This Chapter

This chapter provides the following:

• A description of the information Lan Script carries forward to Microsoft SMS.

• An explanation of the basic procedure for scheduling distribution jobs, and
subsequently monitoring the progress of the distribution.

• The procedure you should follow should a distribution job fail.

It does not cover the use of Microsoft SMS in detail. For a comprehensive explanation of the
distribution procedure, refer to your Microsoft SMS documentation.
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The Microsoft SMS Administrator Screen

All aspects of package distribution are carried out from the Microsoft SMS Administrator
screen. To be able to distribute a package, you must have the following windows open:

• The Packages window, which lists the packages that are available for distribution.

 To open this window, click on .

• The Sites window, which shows the domains, servers and workstations to which the
packages can be distributed.

 To open this window, click on .

The packages
available for
distribution.

The sites to which
packages can be
distributed.
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Information Lan Script Carries Forward to Microsoft SMS

Lan Script automatically carries forward a range of information to Microsoft SMS that you
would usually have to enter manually. These details are illustrated below and on the following
pages.

To show general details about a package, double click on it in the Packages Window in the
Microsoft SMS Administrator screen. The Package Properties window is displayed:

The  and  buttons at the bottom of this window provide further information
about the package.

Workstation Details

Clicking on  displays the following window:

The source directory, i.e.
the directory in which the
package is held, is
completed by Lan Script.
(The share is as specified in
SMS.INI on the client that
performed the upload.)

General package details,
brought forward from stage 2
of the script generation
procedure (see page 2.6.)
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To display further details for either the install or uninstall script, highlight the appropriate line
and click on . The following window is then displayed:

Inventory Details

Clicking on  displays the following window:

Lan Script completes the
Command Line field, showing
the command that runs this
script, and indicates which
Supported Platform the
package can be distributed to.

If you chose to include the
package in the Microsoft SMS
software inventory (at stage 6 of
the script generation procedure,
see page 2.13), Lan Script
completes this window to show
the files used by Microsoft SMS
to detect the presence of the
package (these were specified at
stage 10 of the script generation
procedure, see page 2.19).
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Scheduling a Package For Distribution

To schedule a package for distribution to your workstations, follow the steps below:

1. In the Microsoft SMS Administrator screen (see page 5.4), drag the package you want to
distribute onto the site you want to distribute it to. You can drag the package onto:

• The enterprise (in which case it is distributed to all servers and workstations within
the enterprise).

• A domain (in which case it is distributed to all servers and workstations within the
domain).

• An individual server or workstation.

2. The Job Properties window displays briefly, and is then replaced shortly afterwards by
the Job Details window:

This window displays details about the distribution job you have selected. Check the
details shown, and make any changes you require. When the details are correct, click on

 to distribute the package.

" Refer to your Microsoft SMS documentation for details about the fields in this window.
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3. The Job Properties window is displayed:

The buttons at the bottom of the window are available to carry out the following
functions:

Return to the Job Details window (see the previous page), from where you
can view general details about the distribution to be carried out and change
them if required.

Display the Job Schedule window, from where you can view the scheduling
settings assigned to the job and change them if required.

This button is not applicable at this stage. It is used after the job has been
scheduled for distribution, to monitor its progress (see page 5.10).

Click on  in the Job Properties window to schedule the job for distribution.
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4. The Jobs window is displayed. The new job is assigned an ID, and is shown in the top line
as pending distribution:

" The SMS Client must be installed and active on each workstation that is to receive
the package.

If you are using the 32 bit version of Lan Script, then when the package is being
installed on a workstation running Explorer, the disk icon  is displayed in the
systray (in the bottom right-hand corner of the workstation screen, next to the clock).
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Monitoring the Progress of a Job

To monitor the progress of a job scheduled for distribution, click on . The Jobs window is
displayed, listing the packages that have been scheduled for distribution and/or have been
distributed (see the previous page).

To display further information about any of these jobs:

1. Double click on the job. The Job Properties window is displayed (see page 5.8).

2. Click on the  button to display the Job Status window:

The top of the window shows the overall status of the job.

Each line in the main window area shows the progress of the job at each site to which it is
being distributed.
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3. To display further details about the progress of the job at any site, either highlight the
appropriate line and click on , or double click on it. The Job Status Details
window is then displayed:

Jobs with status ‘Complete’ have worked successfully. The Lan Script install client
(INSCL16.EXE or INSCL32.EXE as appropriate) generates a status MIF, which can be
viewed from the Event Detail window, indicating that such jobs have completed
successfully. See page 5.15 for further details.

Jobs with the following statuses have failed or encountered errors:

• ‘Retrying’

• ‘Cancelled’

• ‘Failed’

The procedure you should follow for failed jobs is explained on pages 5.13 to 5.16.
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Unsuccessful Jobs and The Rollback Function

When carrying out any installation from Microsoft SMS there is the possibility of a job failure.
This may result in the workstations affected being left in a partially configured state, which
can lead to registry and INI entries that do not correspond to installed files and icons.

To prevent the possibility of discrepancies, Lan Script provides a rollback function. This
ensures that the workstation continues to function in the same way as before the script was
executed. It does this by:

• Restoring the registry to its previous state.

• Restoring INI, AUTOEXEC.BAT, CONFIG.SYS, program groups, icons and
shortcuts back to their previous states.

If the installation of a package fails, the following message is displayed on all workstations
affected:

The user of each workstation can choose to:

• Click on  to restore their machine, or

• Click on  if they do not want their machine to be restored.

"
Whilst the rollback function ensures that the workstation continues to function in the same
way as before the script was executed, this does not necessarily mean that it is restored to
its original state. The rollback does not remove files that were added to the workstation by
the script or restore updated DLLs to their previous state.

If you are using the 16 bit version of Lan Script, the rollback function can be switched off by
removing the cross from the Installation Backup field in the Installation Options tab. See
page 3.6 for details.
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The Procedure If a Job Fails

If a job fails, you should follow three steps to rectify the error:

1. Cancel the job so that Microsoft SMS does not attempt to distribute it to any further
machines. See below for details.

2. Determine the reason for the failure, and check whether each workstation affected has
been ‘rolled back’ to function in the same way as it did prior to the installation. See page
5.14.

3. For workstations that have not been rolled back, remove the software that has been
installed. Usually you will be able to run the uninstall script to do this. See page 5.17.

When you have carried out these three steps, you can then try again to distribute the job. To do
this:

• Correct the errors that caused the failure by editing the script (see Chapter 3).

• Upload the revised scripts to Microsoft SMS (see Chapter 4).

• Reschedule the job.

Cancelling a Failed Job

To cancel a job that has failed:

1. Click on the  button in the Microsoft SMS Administrator screen to display the Jobs
window (see page 5.9). This window lists all packages that have been scheduled for
distribution and/or have been distributed.

2. Highlight the job to be cancelled.

3. Select Cancel Job from the Edit pull down menu.
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Determining the Reason For a Job Failure

When you have cancelled the job, you should determine the reason for it failing and whether a
rollback was performed on each machine affected. To do this:

1. Click on the  button in the Microsoft SMS Administrator window to display the
Events window:

Each line in this window represents one event, i.e. an attempt to install the package on one
workstation or server.

The icon at the left of the line indicates the success or otherwise of the event:

 Information icon: successful event.

 Stop icon: failed event.
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2. To display further details about an event, double-click on it.

The following examples show typical details that would be displayed for failed
installations that 1. was restored, and 2. could not be restored, respectively:

The reason for the event
failing, obtained from the
Status MIF file created by
Lan Script.

In this case, the bottom line
indicates that the workstation
was restored successfully.

In this example, the machine
was not restored.
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How Lan Script Communicates Success or Failure to SMS

The Lan Script install client (INSCL16.EXE or INSCL32.EXE as appropriate) generates a
status MIF text file for each distribution. This is a text file that indicates whether the job
succeeded or failed, and in the case of failure, the cause of the error and whether or not the
workstation was restored.

The status MIF file is assigned a name based on the package being distributed, e.g. the status
MIF file for a package called AURORA would be called AURORA.MIF. It is written to the
Windows directory of the machine on which the software was being installed.

The Microsoft SMS Package and Command Manager reads this MIF file when the install
client has finished executing, sends its contents to the SMS Server and deletes the MIF file
from the Windows directory.

These details are then available for review from the Event Details window (see the previous
page).
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Running an Uninstall Script

For workstations that have not been rolled back, you must remove the software that has been
installed. Usually, you will be able to run the uninstall script to do this.

To run an uninstall script:

1. Access the Job Details window (see page 5.7).

2. Change the Run Workstation Command selection to Automated Uninstall.

3. Click on  to start the uninstall.

Because certain system files may be shared components, by default the uninstall script does
not:

• Delete files from the Windows or Windows\System directories.

• Delete sections from INI files.

• Change or delete items from the System Registry.

(You can change these default settings by editing the uninstall script - see Chapter 3 for
details.)
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Appendix A:

Installation Instructions

This Appendix provides the instructions you require to install the Lan Script service on
your server, and the Lan Script application on your client workstation. It also covers the
procedure for subsequently removing your Lan Script installation if required.

This Appendix Contains

• System Requirements   A.2

• An Overview of the Installation Process   A.2

• Installing the ABC Lan Script Service On Your Server   A.3

• Installing Lan Script On Your Client Workstation   A.7

• Removing the ABC Lan Script Service From Your Server  A.8

• Removing Lan Script From Your Client Workstations   A.8
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System Requirements

Supported Server Platforms

As Lan Script is a tool developed specifically for Microsoft Systems Management Server,
Windows NT is the only supported server platform. At this release Windows NT versions 3.51
and 4.0 are supported.

Supported Client Platforms

• Windows 3.x

• Windows for Workgroups 3.x

• Windows 95

• Windows NT v3.51 and v4.0

An Overview of the Installation Process

The installation process can be divided into two stages:

1. Installing the ABC Lan Script service onto your Microsoft SMS server
The section beginning on the page opposite explains how to install the ABC Lan Script
service onto a Windows NT server running Microsoft SMS. This should be the SMS
server to which you want to upload the scripts that are generated using ABC Lan
Script.

2. Installing Lan Script on your client workstation
The section beginning on page A.7 explains how to install the Lan Script monitoring
tool onto your workstation.
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Installing the ABC Lan Script Service On Your Server

This section explains how to install the ABC Lan Script service onto a Windows NT server
running Microsoft SMS. This should be the SMS server to which you want to upload the
scripts that are generated using ABC Lan Script.

To install the ABC Lan Script Service:

1. Make sure that all programs are closed down, and insert the license disk into your
floppy disk drive A:.

" If you have an evaluation copy of Lan Script, then no license disk is required, as the
installation defaults to an evaluation license.

2. Insert the Lan Script CD-ROM into your CD-ROM drive, make a connection from your
workstation if necessary, and run SETUP.EXE.

To install the 16 bit version of Lan Script, you should run the version of SETUP.EXE
held in the SCRIPT16 subdirectory.

To install the 32 bit version of Lan Script, you should run the version of SETUP.EXE
held in the SCRIPT32 subdirectory.

3: The setup program displays an Initialising... message before going into the main setup
program:
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Click on:

to continue the setup procedure, or

if you don’t wish to carry on installing the service.

4. The next step is to locate the license files that are required to install the service.

If you inserted the license disk requested at step 1, this step is not applicable. Go onto
step 5.

Otherwise you must specify the directory where the Lan Script license files can be found
using the following window:

5. When Lan Script has successfully found the license files you are asked to specify your
user and organisation name:

Enter these details, and click on  to continue the setup procedure.



Appendix A: Installation Instructions

A.5

6. The following screen is displayed:

" The installation procedure installs files to your Windows NT directory. Changing
the installation directory does not have any affect on where the service is installed.

7. The following prompt is then displayed asking you to confirm that the installation is at a
server that has Microsoft Systems Management Server installed on it:

Click on  to confirm that it has.

Click this button to
indicate that you want
to install the ABC Lan
Script Service to your
Server.
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8. You are asked for information regarding the startup of the ABC Lan Script service:

Selecting Start service on system startup ensures that the ABC Lan Script service is
started automatically whenever the server is rebooted.

When you have completed these details, click on  to continue.

9. The setup program then starts to copy the files it needs for the service onto your server.
At the end of the file copying process, providing there are no errors, you are prompted:

Please reboot your server to start the ABC Lan Script service.
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Installing Lan Script On Your Client Workstation

To install ABC Lan Script to your client workstation, follow the steps below:

1. The first stages are the same as when installing the ABC Lan Script service onto your
Windows NT server. Follow steps 1 to 5 in the previous section.

2. The following screen is displayed:

3. The setup program then:

• Copies the files required to the directory that you specified.

• Creates an icon for Lan Script. If you are using the Explorer shell on your
workstation then this will appear on the Programs menu.

The following dialogue is displayed when this is complete:

Click on  to close this window and finish the procedure.

Use this button if you
want to change the
directory to which the
files are installed.

Click this button start
the installation of Lan
Script.
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Removing the ABC Lan Script Service From Your Server

To remove the ABC Lan Script service from your server, run the following command from
your Lan Script CD-ROM:

SCRIPT16\SERVER\SETUPSVR.EXE /r

SCRIPT32\SERVER\SETUPSVR.EXE /r

Removing Lan Script From Your Client Workstations

To remove Lan Script from a Windows 95 workstation, follow the steps below:

1. Launch Control Panel and choose Add/Remove Programs.

2. Highlight ABC Lan Script in the list displayed and choose Add/Remove.

3. The uninstall program starts. Confirm that you do want to remove Lan Script when
prompted. Lan Script is then removed.

To remove Lan Script from a Windows NT workstation or server, follow the steps below:

1. Run the Remove ABC Lan Script icon from the ABC Lan Script group.

2. The uninstall program starts. Confirm that you do want to remove Lan Script when
prompted. Lan Script is then removed.

" In both cases, if any of the Lan Script files are shared with other installed programs, you
are asked whether you want to remove these before they are deleted.
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Scripting Commands

This Appendix provides a reference of the scripting commands used.

" All of the Lan Script commands use the pipe symbol ‘|’ or ‘¦’ as a delimiter to
separate the various fields in the commands, as this is a character not used in file
names (See page B.40 for further details.)

This Appendix Contains

• Summary of Commands   B.2

• File Commands   B.6

• Directory Commands   B.12

• Tree Commands   B.15

• Text File Editing Commands   B.17

• INI File Editing Commands   B.21

• Registry Commands   B.25

• Shell Commands   B.27

• Connection Commands   B.30

• Icon Commands   B.33

• Conditional Commands   B.35

• Miscellaneous Commands   B.38

• Substitutions   B.39

• Use of Pipe Symbols Within Scripts   B.40
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Summary of Commands

File Commands

Command Action See page ...

FileCreate Creates an empty file. B.7

Kill Deletes a file. B.8

FileCopy Copies a file from one location to another. B.9

FileMove Moves a file from one location to another. B.10

FileRename Renames a file. B.11

Directory Commands

Command Action See page ...

KillDir Deletes all files in the specified directory, leaving the B.12
directory structure intact.

DirCopy Copies all files from the source directory to the destination B.12
directory. If the destination doesn’t exist, it is created.

RmDir Removes a directory and its contents. B.13

DirMove Moves all files in a directory to a specified directory. If the B.13
specified directory doesn’t exist, it is created.

MkDir Creates a directory from the path specified. If any of the B.14
parent directories in the path do not exist, they are created.
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Tree Commands

Command Action See page ...

TreeCopy Copies the directory specified, including all files and B.15
subdirectories, to the destination path specified. If the
destination directory doesn’t exist, it is created.

KillTree Deletes all files and the structure of directories and any B.15
subdirectories.

MoveTree Moves all files and any subdirectories from a specified B.16
directory to a destination directory. If the destination
directory doesn’t exist, it is created.

Text File Editing Commands

Command Action See page ...

FindReplace Runs a find and replace routine, either on a file, or on the B.17
entries in a specified section of an INI file.

TXTInsertEnd Adds a line of text at the end of the text file. B.18

TXTInsertStart Adds a line of text at the start of the text file. B.18

TXTDeleteLine Deletes a line of text from a text file. B.19

TXTInsertMid Inserts a line of text into a text file, after the line specified. B.19

TXTReplaceLine Replaces a line of text in a text file. B.20

TXTAppendLine Adds text at the end of a line of text that already exists. B.20
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INI File Editing Commands

Command Action See page ...

WritePrivateProfileString Writes a value to an INI file. B.21

CopyINISection Copies a section from an INI file, and adds it to another. B.22

DeleteINISection Deletes an INI section from a file. B.23

CopyINIValue Copies a keyname and its value from one INI file to a specified B.23
section of another INI file.

DeleteINIValue Deletes a specified keyname from an INI file. B.24

Registry Commands

Command Action See page ...

AbcRegisterDLL Registers DLLs or OCXs that are OLE Automation Servers B.25
or Components. (Available only with the 32 bit version of
Lan Script.)

AbcRegisterEXE Registers executables that act as OLE Automation Servers. B.25
(Available only with the 32 bit version of Lan Script.)

MergeAbcRegistry Merges our Registry file format with the System Registry. B.26
(Available only with the 32 bit version of Lan Script.)

AddToReg Merges .REG files into the System Registry B.27
(Available only with the 16 bit version of Lan Script.)
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Shell Commands

Command Action See page ...

Shell Runs the program specified. B.28

ShellWait Runs the program specified and waits for it to terminate before B.29
continuing the execution of the script.

Connection Commands

Command Action See page ...

Connect Connects the specified server share to a local drive letter. B.30

Disconnect Disconnects a redirected drive. B.30

AutoConnect Connects a specified server share and maps it to a string. B.31

AutoDisconnect Disconnects a server share connected by AutoConnect. B.32

Icon Commands

Command Action See page ...

AddIconGroup Adds a group to the desktop. B.33

DeleteIconGroup Deletes a group from the desktop and the group file B.33
from the hard disk.

AddIcon Adds an icon to a group on the desktop. B.34

DeleteIcon Deletes an icon from a group. B.34
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Conditional Commands

Command Action See page ...

If Exist Determines whether files, INI sections or INI section B.35
keynames exist, and if so executes a command, otherwise
it executes a different command.

If Not Exist Determines whether files, INI file sections or INI section B.36
keynames exist, if not it executes one command, else it
executes a different command

Goto Jumps to the first occurrence of a specified label in the B.37
script and continue to execute the script from the line
directly after the label.

Miscellaneous Commands

Command Action See page ...

Delay Delay the execution of a script for a specified number of B.38
seconds.

WriteFailedMif Stops the execution of a script if required, and writes out B.38
a failed MIF with text supplied in the command.
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File Commands

FileCreate

Action Creates an empty file.

Command FileCreate|(filename)|(overwrite flag)

Argument Description

filename The path and name of the file to be created.

overwrite flag Flag set to decide whether to overwrite existing file, if it already
exists.

/Y to overwrite.

/N to not (default).

Example FileCreate|C:\SCRIPT.LOG|/N

Would create an empty file called SCRIPT.LOG on the root of drive C: only if a file by that
name did not exist already.

The same would happen if the /N parameter was left off, for example,

FileCreate|C:\SCRIPT.LOG

Whereas, if the '/N' was replaced with '/Y' an empty file called SCRIPT.LOG would be
created overwriting an existing file if it existed.

If the file to be created already exists and no overwrite was specified then this command will
NOT raise an error and will continue executing the script.
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Kill

Action Deletes a file

Command Kill|(filename)|(tree flag)

Argument Description

filename Path and name of file to delete.

tree flag Flag set to determine whether to traverse any subdirectories, and
delete any files we find in these subdirectories.

/T to delete all files in the directory tree.

/D to delete files in current directory only.(default)

Comments This command allows the use of wildcard expressions in the filename parameter. If the /T
flag is set the command will traverse any subdirectories and execute the command there
also. This command will not delete any directories. If you want to delete directories then you
should use the KillDir command or the KillTree command if there is a directory structure
that you want to delete.

Example Kill|C:\Script.log|/T

Would delete the file Script.log from the root directory. It would then search any
subdirectories, for files matching the filename specified and delete those as well.

If no files are found that match the filename specified, this command will NOT raise an
error and will continue executing the script.
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FileCopy

Action Copies a file from one location to another.

Command FileCopy|(source)|(destination)|(overwrite flag)

Argument Description

source Source path and filename to copy from.

destination Destination path and filename to copy to.

overwrite flag Flag set to decide whether to overwrite existing files.

/Y to overwrite.

/N to not (default).

Comments This command allows the use of wildcard expressions in the source and destination
parameters.

Note: When copying a file, version checking is implemented to ensure that the file is not
copied over a newer file of the same name, unless the overwrite switch is used. Lan
Script also distinguishes between different language versions of a file, e.g. a French
executable will not be replaced with a German one.

Example FileCopy|\\Server1\Apps\Fin_Drft.doc|C:\Final.doc|/Y

Would copy the file Fin_Drft.doc from the Apps share on the server Server1 to the root of
drive C: as Final.doc overwriting the file if it already exists.
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FileMove

Action Moves a file from one location to another.

Command FileMove|(source)|(destination)|(overwrite flag)

Argument Description

source Source path and filename of file to move.

destination Destination path and filename to move file to.

overwrite flag Flag set to decide whether to overwrite existing files.

/Y to overwrite.

/N to not (default).

Comments This command allows the use of wildcard expressions in the source and destination
parameters.

Note: If wildcards for the source and destination are not chosen with care, multiple files
can be copied over each other into one destination filename. For example, the
command FileMove|TEMP.*|*.EXT|/Y would move all files with the filename
TEMP one by one to a file called TEMP.EXT, overwriting TEMP.EXT each time a
file is moved. This results in all the source files being deleted, except the final one
that is moved.

Example FileMove|C:\Script.log|S:\Script.tmp| /Y

Would move the file Script.log on the root of drive C: to the root of drive S:, changing the
extension to .TMP and writing over any file that already existed.
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FileRename

Action Renames a file.

Command FileRename|(source)|(destination)|(tree flag)

Argument Description

source Source path and filename of file to rename

destination Filename to rename file to.

tree flag Flag set to determine whether to traverse any subdirectories,
executing command.

/T to execute command on file tree.

/D to execute command in directory only. (default)

Comments This command allows the use of wildcard expressions in the source and destination
parameters.

You must not specify the full path in the destination argument, just the file name. If you
want to rename files and move them at the same time then use the FileMove command.

If the /T flag is set the command will traverse any subdirectories and execute the command
there also.

Note: If wildcards for the source and destination are not chosen with care, multiple files
can be copied over each other into one destination filename. For example, the
command FileRename|TEMP.*|*.EXT|/Y would rename all files with the filename
TEMP to a file called TEMP.EXT, overwriting TEMP.EXT each time a file is
renamed. This results in all the source files being deleted, except the final one that is
renamed.

Example FileRename|C:\Documents\Fin_Drft.doc|C:\Final.doc|/Y

Would rename Fin_Drft.doc to Final.doc, in the root directory, writing over any previous
instances of the file.
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Directory Commands

KillDir

Action Deletes ALL files in the specified directory leaving the directory structure intact.

Command KillDir|(directory)

Argument Description

directory Path of directory to delete files from.

Example KillDir|D:\Docs

Would delete all files held in the directory D:\Docs, including system, hidden and read-only
files, but the directory D:\Docs would not be deleted.

DirCopy

Action Copies all files from the source directory to the destination directory. If the destination
doesn’t exist, it is created.

Command DirCopy|(source dir)|(destination dir)|(overwrite flag)

Argument Description

source dir Path of directory to copy files from.

destination dir Path of directory to copy files into.

overwrite flag Flag set to decide whether to overwrite existing files.

/Y to overwrite existing files.

/N to not (default).

Example DirCopy|D:\SprdShts|E:\SprdShts|/N

Would copy all the files in D:\SprdShts to E:\SprdShts, not copying over any files that
already exist in E:\SprdShts.
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RmDir

Action Removes a directory and its contents.

Command RmDir|(directory)

Argument Description

directory Path of directory to be removed.

Comments The directory is only removed if it has no subdirectories.

Example RmDir|D:\Pres

Would remove all files in D:\Pres then remove the directory itself.

DirMove

Action Moves all files in a directory to a specified directory. If the specified directory doesn’t exist,
it is created.

Command DirMove|(source dir)|(destination dir)|(overwrite flag)

Argument Description

source dir Path of directory to move files from.

destination dir Path of directory to move files to.

overwrite flag Flag set to decide whether to overwrite existing files.

‘/Y’ to overwrite.

‘/N’ to not (default).

Example DirMove|C:\MyData|D:\OldData|/Y

Would move all files from the directory C:\MyData to the directory D:\OldData, writing
over any previous instances of the files in the directory D:\OldData.
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MkDir

Action Creates a directory from the path specified. If any of the parent directories in the path do not
exist, they are created.

Command MkDir|(directory)

Argument Description

directory Path of directory to be created

Example MkDir|\\Server1\Apps\Docs\Shared\Sales

Would create the Sales directory, and would also create the parent directories if they do not
exist.
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Tree Commands

TreeCopy

Action Copies the directory specified, including all files and subdirectories, to the destination path
specified. If the destination directory doesn’t exist, it is created.

Command TreeCopy|(source dir)|(destination dir)|(overwrite flag)

Argument Description

source dir Path to copy tree from.

destination dir Path to copy tree to.

overwrite flag Flag set to decide whether to overwrite existing files.

/Y to overwrite.

/N to not (default).

Example TreeCopy|C:\MyData|\\Server1\Home\MyData
Would copy all the files and subdirectories (including their files) from C:\MyData to
\\Server1\Home\MyData, creating any directories that do not exist, using the default setting
for the overwrite flag, and not overwriting any existing files.

KillTree

Action Deletes all files and the structure of directories and any subdirectories.

Command KillTree|(directory)

Argument Description

directory Path of root of the tree to remove.

Example KillTree|D:\Pres
Would delete all files and subdirectories of D:\Pres, and then delete D:\Pres.
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MoveTree

Action Moves all files and any subdirectories from a specified directory to a destination directory.
If the destination directory doesn’t exist, it is created.

Command MoveTree|(source dir)|(destination dir)|(overwrite flag)

Argument Description

source dir Path to move tree from.

destination dir Path to move tree to.

overwrite flag Flag set to decide whether to overwrite existing files.

/Y to overwrite.

/N to not (default).

Example MoveTree|G:\Public|E:\Shared|/Y

Would move all files and subdirectories in G:\Public to E:\Shared.
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Text File Editing Commands

FindReplace

Action Runs a find and replace routine, either on a file, or on the entries in a specified section of an
INI file.

Command FindReplace|(file)|(text to find)|(replacement)|(section)

Argument Description

file Path and file to operate on.

text to find String to look for.

replacement String to replace with if found.

section Section to examine. See ‘Comments’.

Comments The value in the section argument controls the whole operation of the command. If it is set to
‘ALL’ the whole file will be searched (this MUST be in capitals). Otherwise the value is
treated as the name of an INI section and only that section is searched.

It should be noted when using this command that it is case insensitive when looking for the
source string in the file, and it will replace all occurrences of the string, even if they are
parts of other words.

Example FindReplace|C:\Backup.ini|MyData|Data|Location

Would search through the values of all the entries in the Location section of C:\Backup.ini
replacing any occurrences of MyData with Data.

FindReplace|C:\Backup.ini|MyData|Data

Would search through the whole of the file C:\Backup.ini looking for occurrences of
MyData and replacing any found with Data.
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TXTInsertEnd

Action Adds a line of text to the end of text file.

Command TXTInsertEnd|(filename)|(text to add)

Argument Description

filename The name of the file to which the line of text will be added.

text to add The line of text to add to the file

Example TXTInsertEnd|C:\Autoexec.bat|SET HelpFiles=W:\Word6\Hlp

Would add the line SET HelpFiles=W:\Word6\Hlp to the end of the AUTOEXEC.BAT file.

TXTInsertStart

Action Adds a line of text at the beginning of a text file.

Command TXTInsertStart|(filename)|(text to add)

Argument Description

filename The name of the file to which the line of text will be added.

text to add The line of text to add to the file

Example TXTInsertStart|C:\Autoexec.bat|@ Echo Off

Would add the line @ Echo Off to the start of Autoexec.bat.
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TXTDeleteLine

Action Deletes a line of text from a text file.

Command TXTDeleteLine|(filename)|(beginning of line to delete)

Argument Description

filename The name of the file from which the text will be deleted.

beginning of line to delete The start of the line of text to be deleted.

Comments This command will search through the filename specified attempting to match the start of the
line given with those in the filename. If it finds a match with the start of the line it will
remove that line from the text file.

Example TXTDeleteLine|C:\Autoexec.bat|SET HelpFiles
Would delete the first line it came across that started with the text SET HelpFiles from
Autoexec.bat.

TXTInsertMid

Action Inserts a line into a text file after the line specified.

Command TXTInsertMid|(filename)|(text to add)|(add text after this line)

Argument Description

filename The file to which the line of text will be added.

text to add The line of text to add to the file.

add text after this line A line of text to indicate where, in the file, the new line of text is to
be added.

Comments If the line specified to add this line after isn’t found then the line is not added.

Example TXTInsertMid|C:\Autoexec.bat|SET Lib=X:\Lib| SET Help=W:\Help
Would add the line SET Lib=X:\Lib after the line SET Help=W:\Help in Autoexec.bat.
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TXTReplaceLine

Action Replaces a line of text in a text file.

Command TXTReplaceLine|(filename)|(beginning of line to replace)|(text to replace with)

Argument Description

filename The name of the file in which the line of text will be replaced.

beginning of line to
replace

The start of the line of text to be replaced.

text to replace with The new text to replace the old with.

Comments If the line to replace isn’t found then this line is added to the end of the file.

Example TXTReplaceLine|C:\Autoexec.bat|SET Lib=X:\Lib|SET Lib=X:\Library
Would find and replace the line that started with SET Lib=X:\Lib and replace it with SET
Lib=X:\Library in Autoexec.bat.

TXTAppendLine

Action Adds text at the end of a line of text that already exists.

Command TXTAppendLine|(filename)|(beginning of line to append)|(text to append)

Argument Description

filename The name of the file in which the line of text will be appended.

beginning of line to
append

The start of the line of text to be appended.

text to append The new text to append.

Example TXTAppendLine|C:\Autoexec.bat|SET Lib=X:\C600|;X:\MSVC\LIB
Would find the line that started SET Lib=X:\C600, and append the text ;X:\MSVC\LIB to
the end of it in Autoexec.bat.
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INI File Editing Commands

WritePrivateProfileString

Action Writes a value to an INI file.

Command WritePrivateProfileString|(Section Name)|(Key Name)|(Value)|(INI File)

Argument Description

Section Name Name of INI section

Key Name Name of the key under the Section

Value Value of key

INI File Name and path of the INI file to modify

Comments If the Key already exists under the specified section then it is modified with the new value. If the
Key or Section does not exist then it is created. This command can be used to add multiple
“device=” entries which can be found under the 386Enh section of the system.ini. It can also be
used for appending extra items to the run= and load= entries in the windows section of win.ini.
There are three cases where this command is especially useful:

1. Device= in the 386Enh section of system.ini. The command will append the device= to the
section if it is not already in the section.

2. Run= in the Windows section of win.ini. The new value will be appended to the existing
string in the run= key if there is already a value specified.

3. Load= in the windows section of win.ini. The new value will be appended to the existing
string in the load= key if there is already a value specified.

Example WritePrivateProfileString|Windows|Run|Notepad.exe|c:\windows\win.ini

Would write the following line to the WIN.INI in the Windows directory if the ‘Run=’entry was
blank.

[Windows]
Run=Notepad.exe

If the user had an existing “Run=Write.exe” then it would be updated to read:

[Windows]
Run=Write.exe,Notepad.exe

(If this was not ‘Run=’, it would replace Write.exe with Notepad.exe, rather than appending.)
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CopyINISection

Action Copies a section from an INI file and adds it to another.

Command CopyINISection|(source)|(source section)|(destination)|(destination section)|(overwrite flag)

Argument Description

source INI file to copy section from.

source section INI section to copy from source INI file.

destination INI file to copy section into.

destination section INI section name in destination file to copy section into.

overwrite flag Flag set to decide whether to overwrite existing files.

/Y to overwrite.

/N to not (default).

Comments As this command executes it checks to see if the INI section already exists in the destination
file; if it exists, as each keyname is copied the command checks to see if that keyname
already exists in the destination INI section, if it does then it uses the overwrite flag to
decide whether the keyname is written to the file or not. If the INI section doesn’t exist then
it will create the section and copy the keynames into the section.

Example CopyINISection|C:\Files.ini|Personal|C:\Backup.ini|MyFiles|/N

Would copy the INI section Personal in C:\Files.ini to a section called MyFiles in
C:\Backup.ini, creating the section and the file, if they don’t exist. If the section does exist in
Backup.ini, the command would only copy keynames into that section that did not already
exist.
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DeleteINISection

Action Deletes an INI section from a file.

Command DeleteINISection|(File)|(Section)

Argument Description

file INI file (and path) containing section.

section INI section to be deleted.

Example DeleteINISection|C:\Files.ini|Personal
Would delete the INI section Personal from the file C:\Files.ini.

CopyINIValue

Action Copies a keyname and its value from one INI file to a specified section of another INI file.

Command CopyINIValue|(source)|(source section)|(item)|(destination)|
(destination section)|(overwrite flag)

Argument Description

source Path and file to copy INI value from.

Source section Section to copy INI value from.

item Value to copy.

destination Path and file to copy INI value to.

destination section Section to copy INI value to.

overwrite flag Flag set to decide whether to overwrite existing values.

/Y to overwrite.

/N to not (default).

Example CopyINIValue|C:\Fonts.ini|Fonts|Courier|C:\Fonts.ini|OldFonts
Would copy the keyname Courier (and its value) from the Fonts section of C:\Fonts.ini to
the OldFonts section in the same file.
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DeleteINIValue

Action Deletes a specified keyname from an INI file.

Command DeleteINIValue|(file)|(section)|(item)

Argument Description

file INI file (and path) containing keyname to delete.

section INI section containing keyname to delete.

item INI keyname to be deleted.

Example DeleteINIValue|C:\Backup.ini|MyFiles|Documents

Would delete the keyname documents from the MyFiles section in the file C:\Backup.ini.
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Registry Commands

 
AbcRegisterDLL

Action Registers DLLs or OCXs that are OLE Automation Servers or Components.

Command AbcRegisterDLL|(path to file)

Argument Description

path To DLL This is the path to the DLL or OCX that you want to register and
should include the filename.

Comments Only available with the 32 bit version of Lan Script.

Example AbcRegisterDLL|C:\Windows\System\Threed.ocx

Would register Threed.ocx in the Registry for use with OLE.

 
AbcRegisterEXE

Action Registers executables that act as OLE Automation Servers.

Command AbcRegisterEXE|(path to file)

Argument Description

path to file This is the path to the executable that you want to register and
should include the filename.

Comments Only available with the 32 bit version of Lan Script.

Example AbcRegisterEXE|C:\Windows\System\VB4TEST.EXE

Would register VB4TEST.EXE in the Registry for use with OLE.
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MergeAbcRegistry

Action Merges our Registry file format with the System Registry.

Command MergeAbcRegistry|(Path to Abc Registry file)|(Profiles to Edit)

Argument Description

Path to Abc Registry
file

This is the path to the Abc Registry file that needs to be merged
with the Registry.

Profiles to Edit This used to specify which profile the changes are to be made to. It
can be set to default, all or left blank.

If set to default, it makes the changes to the currently logged on
user’s profile and the default profile.

If set to all, it makes the changes to all profiles, including the
currently logged on user’s profile and the default profile.

If left blank, it makes the changes to the currently logged on user’s
profile only.

Comments Only available with the 32 bit version of Lan Script.

This command uses binary files as well as specially formatted files to add entries to the
Registry and is included in the Command Syntax document only for reference and should
not be used to add entries manually.

Example MergeAbcRegistry|\\Server2\Apps\AbcMerge

Would merge the file AbcMerge into the Registry.
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AddToReg

Action Merges .REG files into the System Registry.

Command AddToReg|(Path to .REG file)

Argument Description

path to .REG file This is the path to the .REG file that needs to be merged with the
Registry.

Comments Only available with the 16 bit version of Lan Script.

Allows you to merge standard Windows Registry files into the Registry.

Example AddToReg|%WINSYS%|OLE2.REG

Would merge the file OLE2.REG in the Windows System directory into the Registry.
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Shell Commands

Shell

Action Runs the program specified.

Command Shell|(command line)|(display type)

Argument Description

command line The program to be executed, along with any parameters or switches

display type A number representing the mode in which the program will be
displayed when it is executed:

1. Hides the window and passes activation to another window.

2. Minimizes the specified window and activates the top-level window
in the system’s list.

3. Activates and displays a window. If the window is minimized or
maximised, Windows restores it to its original size and position.

4. Activates a window and displays it in its current size and position.

5. Activates a window and displays it as a maximised window.

6. Activates a window and displays it as an icon.

7. Displays a window as an icon. The window that is currently active
remains active.

8. Displays a window in its current state. The window that is
currently active remains active.

9. Displays a window in its most recent size and position. The
window that is currently active remains active.

Comments During the execution of a script the script will continue to be processed as soon as the Shell
command has been executed.

Example Shell|Notepad.exe C:\Startup.txt|6

Would run Notepad.exe as an icon on the desktop and open the file C:\Startup.txt.
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ShellWait

Action Runs the program specified and waits for it to terminate before continuing the execution of
the script.

Command ShellWait|(command line)|(display type)

Argument Description

command line The program to be executed, along with any parameters or switches.

display type A number representing the mode in which the program will be
displayed when it is executed:

1. Hides the window and passes activation to another window.

2. Minimizes the specified window and activates the top-level window
in the system’s list.

3. Activates and displays a window. If the window is minimized or
maximised, Windows restores it to its original size and position.

4. Activates a window and displays it in its current size and position.

5. Activates a window and displays it as a maximised window.

6. Activates a window and displays it as an icon.

7. Displays a window as an icon. The window that is currently active
remains active.

8. Displays a window in its current state. The window that is
currently active remains active.

9. Displays a window in its most recent size and position. The
window that is currently active remains active.

Comments This command differs from the Shell command only in that it waits for the program speci-
fied in the ShellWait command to terminate before continuing with the script execution.

Example ShellWait|Notepad.exe C:\Welcome.txt|5

Would run Notepad.exe as a maximised window on the desktop and open the file
C:\Welcome.txt. The script would only continue to run after this copy of Notepad was
closed.
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Connection Commands

Connect

Action Connects the specified server share to a local drive letter.

Command Connect|(drive)|(path)|(password)

Argument Description

drive The drive letter to be connected.

path The path of the server share.

password Password to allow connection. See ‘Comments’.

Comments If the password for the domain is the same as the password given at logon then no password
is needed and the password argument should be left out.

Example Connect|F:|\\Server1\Scripts
Would connect the local drive letter ‘F:’ to Scripts share on Server1.

This saves you from typing in UNC paths in your script files. These connections are
terminated when a Disconnect command is executed or when the script terminates.

If a password was needed and one was not specified, then the execution would stop and an
error message would be registered.

Disconnect

Action Disconnects a redirected drive.

Command Disconnect|(drive letter)

Argument Description

drive letter Letter of the drive to be disconnected.

Example Disconnect|F:

Would disconnect the drive letter F:.
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AutoConnect

Action Connects a specified server share and maps it to a string.

Command AutoConnect|(string)|(path)|(password)

Argument Description

string The string that the drive is to be mapped to. See ‘Comments’.

path The path of the server share.

password Password to allow connection. See ‘Comments’.

Comments Once this command has been executed the string specified can then be used where you
would normally place a drive letter in a parameter of any command.

If the password for the domain is the same as the password given at logon then no password
is needed and the password argument should be left out.

The string that is used to represent the drive should be no more than 10 characters long, and
should finish with a colon.

There is a maximum limit of twenty one connections at any one time, but this limit can be
lower if you have other network connections.

This command connects the server share to a drive letter which is free at the time when the
command is executed; this is then aliased to a string, and the connection stays until either the
AutoDisconnect command is used, or the end of the script is reached.

Example AutoConnect|Link1:|\\Server2\Files

Would make a connection to the Files share on Server2 and alias that to Link1: This can
then be used in further commands until either it is disconnected, or the script ended. You can
then use the alias name in the same way that you would use a drive letter in the Lan Script
commands, for example:

FileCopy|Link1:\Start.doc|C:\Start.doc

Would copy Start.doc from the Files share on Server2 to the root of drive C:
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AutoDisconnect

Action Disconnects a server share connected by AutoConnect.

Command AutoDisconnect|(string)

Argument Description

string String representing the server share to be disconnected.

Example AutoDisconnect|Link2:

Would disconnect the drive that Link2: represents.
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Icon Commands

AddIconGroup

Action Adds a group to the desktop.

Command AddIconGroup|(GroupName)|(GroupFileName)

Argument Description

GroupName The name of the group as you want it to appear on the desktop.

GroupFileName The filename for the group.

Example AddIconGroup|ABC_LS2|C:\Windows\ABC_LS.grp

This would add a group called ABC_LS2 to the desktop that uses
C:\Windows\ABC_LS.grp to contain the information for the icons in the group.

DeleteIconGroup

Action Deletes a group from the desktop and the group file from the hard disk.

Command DeleteIconGroup|(GroupName)

Argument Description

GroupName This is the name of the group to delete and should be the name as
displayed on the desktop.

Example DeleteIconGroup|ABC_LS2

This would delete the ABC_LS2 group from the desktop and also delete the group file from
the hard disk.
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AddIcon

Action Adds an icon to a group on the desktop.

Command AddIcon|(GroupName)|(ExeFilePath)|(IconName)

Argument Description

GroupName This is the name of the group that you want to add the icon to.

ExeFilePath This is the name of the executable file that you want to add to the
group.

IconName This is the description that you want to appear with the icon on the
desktop.

Example AddIcon|ABC_LS2|C:\Smsins32\lanscrpt.exe|ABC Lan Script

This would add an icon to the ABC_LS2 group called ABC_LS that points to the
executable C:\Smsins32\lanscrpt.exe.

DeleteIcon

Action Deletes an icon from a group.

Command DeleteIcon|(GroupName)|(IconName)

Argument Description

GroupName This is the name of the group that the icon is in.

IconName This is the description of the icon.

Example DeleteIcon|ABC_LS2|ABC_LS

This would delete the ABC_LS icon from the ABC_LS2 group.
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Conditional Commands

If Exist

Action Determines whether files, INI sections or INI section keynames exist, and if so executes a
command, otherwise it executes a different command.

Command If Exist “(parm)” AND|OR “(parm)”  Then “(command)” Else “(command)”

Argument Description

parm One of the following:

• a file.

• a file, INI section.

• a file, INI section, keyname.

• a keyname value.

command One of the following:

• any of the previously defined functions.

• a goto statement which directs the flow of the script execution
to another part of the script file.

Both arguments must be surrounded by double quotes (" ").

Comments The parm argument must be surrounded by double quotes, and each part (file, section, ele-
ment) must be separated by a pipe. Any spaces surrounding the pipes will be ignored.

The Command argument can consist of any command from the previously defined
commands with all its arguments, or can be a goto, and the full command also must be
surrounded with double quotes.

Example If Exist "C:\Autoexec.bak" And "C:\Boot.ini|System|Network" Then
"FileCreate|C:\Autoexec.001" Else "Goto :END"

Would see if the file C:\Autoexec.bak and the Network keyname in the System section of the
file C:\Boot.ini existed. If they both existed it would execute the FileCreate command, if not
it would execute the Goto command and jump to the “:END” label.
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If Not Exist

Action Determines whether files, INI file sections or INI section keynames exist, if not it executes
one command, else it executes a different command.

Command If Not Exist “(parm)” AND|OR “(parm)”  Then “(command)” Else “(command)”

Argument Description

parm One of the following:

• a file.

• a file, INI section.

• a file, INI section, keyname.

• a keyname value.

command One of the following:

• any of the previously defined functions.

• a goto statement which directs the flow of the script execution
to another part of the script file.

Both arguments must be surrounded by double quotes (" ").

Comments The parm argument MUST be surrounded by double quotes, and each part (file, section,
element) must be separated by a pipe, any spaces surrounding the pipes will be ignored.

The Command can consist of any command from section three with all its arguments, or can
be a goto, and the full command also must be surrounded with double quotes.

Example If Not Exist "C:\Config.bak" OR "C:\Boot.ini|System|Network" Then
"FileCreate|C:\Config.001" Else "Goto :END"

Would see if the file C:\Config.bak and the Network keyname in the System section of
C:\Boot.ini existed. If either of them did not it would execute the FileCreate command; if
they both existed it would execute the Goto command and jump to the “:END” label.
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Goto

Action Jumps to the first occurrence of a specified label in the script and continue to execute the
script from the line directly after the label.

Command Goto (:label)

Argument Description

:label a colon directly followed by a string that represents a label that
exists somewhere in the script.

Comments There must be an associated label somewhere in the script.

Example Goto :Place12

Would look for the label :Place12 and execute the command sequence directly following it.
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Miscellaneous Commands

Delay

Action Delays the execution of a script for a specified number of seconds.

Command Delay|(number of seconds to delay for)

Example Delay|10

WriteFailedMif

Action Stops the execution of a script if required, and writes out a failed MIF with text supplied in
the command.

Command WriteFailedMif|(text to return)

Example [MASTER]
FileCopy|%PackageDir%\External.exe|%WinSys%\External.exe
If Not Exist "%WinSys%\External.exe" then "Goto :Rollback"
Goto :End
:Rollback
WriteFailedMif|Script failed
:End
END

These commands:

• Copy the file External.exe to the Windows system directory.

• Check to make sure that the file has been copied successfully. If it has not, a failed MIF
is written stating that the ‘Script failed’.



Appendix B: Scripting Commands

B.39

Substitutions

There are five strings that you can use when writing a script which will be substituted by Lan
Script when the script is executed:

%SiteServer% This is the UNC path to the share that the scripts are uploaded to.

%PackageDir% When the script is distributed, this is the directory from which the
package is executed.

%Win% This is the current Windows directory on the workstation that is
executing the script.

%WinSys% This is the current Windows System directory on the workstation
that is executing the script.

%User% This is the name of the user logged on at the workstation executing
the script.

You can also substitute any DOS environment variables that have been set on the workstation.
For example, if you had SET TEMP = C:\TEMP and then used %TEMP% in the script,
C:\TEMP would be used instead. Therefore, if you have applications installed in different
directories on different workstations, e.g. C:\MSOFFICE and D:\MSOFFICE, you could pick
up an environment variable to decide where to install it.
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Use of Pipe Symbols Within Scripts

All of the Lan Script commands use the pipe symbol ‘|’ or ‘¦’ as a delimiter to separate the
various fields in the commands. If you encounter a pipe symbol in the script as part of a
section or value etc., it should be enclosed by a tilde ‘~’, so that it is recognised as a pipe
symbol and not a delimiter. For example: ‘(~¦~(Hello’.
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